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1 Introduction
1.1 About this Manual

This manual provides information on how to set and configure the device
parameters of a netX based EtherCAT Slave device within a FDT
Framework using the EtherCAT Slave DTM, and what can be read from the
diagnosis panes.

In a network project the EtherCAT Slave DTM can be dropped:
¢ to the root line (Stand-Alone Slave),
e orto the Master busline of a EtherCAT Master DTM.

Note: This manual edition first provides information for the case if the
EtherCAT Slave DTM is dropped to the root line (Stand-Alone Slave) and
in addition important information for the case if the EtherCAT Slave DTM
is dropped to the Master busline of a EtherCAT Master DTM.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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1.11 Descriptions of the Dialog Panes
The table below gives an overview for the individual dialog panes
descriptions:
Section Subsection Manual
Page
Settings Overview Settings 32
Driver 35
Device Assignment 45
Firmware Download 51
Configuration Overview Configuration 58
General 62
General Settings 63
Behavior 69
Messages 76
Description Overview Description 77
XML DDF Viewer 78
Diagnosis Overview Diagnosis 84
General Diagnosis 85
Firmware Diagnosis 87
Extended Diagnosis Overview Extended Diagnosis 88
Tools Overview Tools 96
Packet Monitor 97
IO Monitor 100
Table 1: Descriptions Dialog Panes
1.1.2 Online Help
The EtherCAT Slave DTM contains an integrated online help facility.
» To open the online help, click on Help or press F1.
>
1.1.3 List of Revisions
Index Date Version Component Chapter Revision
3 15-10-22 1.3.x.x ECATSlaveDTM.dII Safety information added throughout the
1.3.x.x ECATSlaveGUI.ocx document.:
2,32, Chapter Safety, section Safety Messages
on Firmware or Configuration Download,
4.5, section Firmware Download and further
safety messages according to firmware
and configuration download.
6 Chapter Online Functions: Safety

messages according to firmware and
configuration download added.

4 17

-02-24 1.1000.x.x
1.1000.x.x

ECATSlaveDTM.dIl | 1.4.1
ECATSlaveGUI.ocx

Section Requirements Internet access
added, Windows 8.1 and Windwos 10
added.

Table 2: List of Revisions

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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114

Conventions in this Manual

®@Hde

Notes, operation instructions and results of operation steps are marked as

follows:

Notes

Important: <important note you must follow to avoid malfunction>

Note: <general note>

<note, where to find further information>

Operation Instructions

1. <instruction>

2. <instruction>
or

»  <instruction>

Results

D <result>

Positions in Figures

The Positions @ @ @ ... or @ @ @ .. or @ , @ ... refer to the

figure used in that section. If the numbers reference to a section outside the
current section then a cross reference to that section and figure is

indicated.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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1.2 Legal Notes

Copyright
© Hilscher Gesellschaft fur Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying materials (in the
form of a user's manual, operator's manual, Statement of Work document
and all other document types, support texts, documentation, etc.) are
protected by German and international copyright and by international trade
and protective provisions. Without the prior written consent, you do not
have permission to duplicate them either in full or in part using technical or
mechanical methods (print, photocopy or any other method), to edit them
using electronic systems or to transfer them. You are not permitted to make
changes to copyright notices, markings, trademarks or ownership
declarations. lllustrations are provided without taking the patent situation
into account. Any company names and product designations provided in
this document may be brands or trademarks by the corresponding owner
and may be protected under trademark, brand or patent law. Any form of
further use shall require the express consent from the relevant owner of the
rights.

Important notes

Utmost care was/is given in the preparation of the documentation at hand
consisting of a user's manual, operating manual and any other document
type and accompanying texts. However, errors cannot be ruled out.
Therefore, we cannot assume any guarantee or legal responsibility for
erroneous information or liability of any kind. You are hereby made aware
that descriptions found in the user's manual, the accompanying texts and
the documentation neither represent a guarantee nor any indication on
proper use as stipulated in the agreement or a promised attribute. It cannot
be ruled out that the user's manual, the accompanying texts and the
documentation do not completely match the described attributes, standards
or any other data for the delivered product. A warranty or guarantee with
respect to the correctness or accuracy of the information is not assumed.

We reserve the right to modify our products and the specifications for such
as well as the corresponding documentation in the form of a user's manual,
operating manual and/or any other document types and accompanying
texts at any time and without notice without being required to notify of said
modification. Changes shall be taken into account in future manuals and do
not represent an obligation of any kind, in particular there shall be no right
to have delivered documents revised. The manual delivered with the
product shall apply.

Under no circumstances shall Hilscher Gesellschaft flir Systemautomation
mbH be liable for direct, indirect, ancillary or subsequent damage, or for
any loss of income, which may arise after use of the information contained
herein.

Liability disclaimer

The hardware and/or software was created and tested by Hilscher
Gesellschaft fir Systemautomation mbH with utmost care and is made
available as is. No warranty can be assumed for the performance or
flawlessness of the hardware and/or software under all application

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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conditions and scenarios and the work results achieved by the user when
using the hardware and/or software. Liability for any damage that may have
occurred as a result of using the hardware and/or software or the
corresponding documents shall be limited to an event involving willful intent
or a grossly negligent violation of a fundamental contractual obligation.
However, the right to assert damages due to a violation of a fundamental
contractual obligation shall be limited to contract-typical foreseeable
damage.

It is hereby expressly agreed upon in particular that any use or utilization of
the hardware and/or software in connection with

¢ Flight control systems in aviation and aerospace;

¢ Nuclear fusion processes in nuclear power plants;

¢ Medical devices used for life support and

e Vehicle control systems used in passenger transport

shall be excluded. Use of the hardware and/or software in any of the
following areas is strictly prohibited:

¢ For military purposes or in weaponry;

¢ For designing, engineering, maintaining or operating nuclear systems;

¢ In flight safety systems, aviation and flight telecommunications systems;
¢ In life-support systems;

e In systems in which any malfunction in the hardware and/or software
may result in physical injuries or fatalities.

You are hereby made aware that the hardware and/or software was not
created for use in hazardous environments, which require fail-safe control
mechanisms. Use of the hardware and/or software in this kind of
environment shall be at your own risk; any liability for damage or loss due
to impermissible use shall be excluded.

Warranty

Hilscher Gesellschaft fir Systemautomation mbH hereby guarantees that
the software shall run without errors in accordance with the requirements
listed in the specifications and that there were no defects on the date of
acceptance. The warranty period shall be 12 months commencing as of the
date of acceptance or purchase (with express declaration or implied, by
customer's conclusive behavior, e.g. putting into operation permanently).

The warranty obligation for equipment (hardware) we produce is 36
months, calculated as of the date of delivery ex works. The aforementioned
provisions shall not apply if longer warranty periods are mandatory by law
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a
(1) BGB [Burgerliches Gesetzbuch; German Civil Code] If, despite of all
due care taken, the delivered product should have a defect, which already
existed at the time of the transfer of risk, it shall be at our discretion to
either repair the product or to deliver a replacement product, subject to
timely notification of defect.

The warranty obligation shall not apply if the notification of defect is not
asserted promptly, if the purchaser or third party has tampered with the
products, if the defect is the result of natural wear, was caused by
unfavorable operating conditions or is due to violations against our
operating regulations or against rules of good electrical engineering

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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practice, or if our request to return the defective object is not promptly
complied with.

Costs of support, maintenance, customization and product care

Please be advised that any subsequent improvement shall only be free of
charge if a defect is found. Any form of technical support, maintenance and
customization is not a warranty service, but instead shall be charged extra.

Additional guarantees

Although the hardware and software was developed and tested in-depth
with greatest care, Hilscher Gesellschaft fir Systemautomation mbH shall
not assume any guarantee for the suitability thereof for any purpose that
was not confirmed in writing. No guarantee can be granted whereby the
hardware and software satisfies your requirements, or the use of the
hardware and/or software is uninterruptable or the hardware and/or
software is fault-free.

It cannot be guaranteed that patents and/or ownership privileges have not
been infringed upon or violated or that the products are free from third-party
influence. No additional guarantees or promises shall be made as to
whether the product is market current, free from deficiency in title, or can be
integrated or is usable for specific purposes, unless such guarantees or
promises are required under existing law and cannot be restricted.

Confidentiality

The customer hereby expressly acknowledges that this document contains
trade secrets, information protected by copyright and other patent and
ownership privileges as well as any related rights of Hilscher Gesellschaft
fir Systemautomation mbH. The customer agrees to treat as confidential all
of the information made available to customer by Hilscher Gesellschaft fir
Systemautomation mbH and rights, which were disclosed by Hilscher
Gesellschaft fur Systemautomation mbH and that were made accessible as
well as the terms and conditions of this agreement itself.

The parties hereby agree to one another that the information that each
party receives from the other party respectively is and shall remain the
intellectual property of said other party, unless provided for otherwise in a
contractual agreement.

The customer must not allow any third party to become knowledgeable of
this expertise and shall only provide knowledge thereof to authorized users
as appropriate and necessary. Companies associated with the customer
shall not be deemed third parties. The customer must obligate authorized
users to confidentiality. The customer should only use the confidential
information in connection with the performances specified in this
agreement.

The customer must not use this confidential information to his own
advantage or for his own purposes or rather to the advantage or for the
purpose of a third party, nor must it be used for commercial purposes and
this confidential information must only be used to the extent provided for in
this agreement or otherwise to the extent as expressly authorized by the
disclosing party in written form. The customer has the right, subject to the
obligation to confidentiality, to disclose the terms and conditions of this
agreement directly to his legal and financial consultants as would be
required for the customer's normal business operation.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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Export provisions

The delivered product (including technical data) is subject to the legal
export and/or import laws as well as any associated regulations of various
countries, especially such laws applicable in Germany and in the United
States. The products / hardware / software must not be exported into such
countries for which export is prohibited under US American export control
laws and its supplementary provisions. You hereby agree to strictly follow
the regulations and to yourself be responsible for observing them. You are
hereby made aware that you may be required to obtain governmental
approval to export, reexport or import the product.

1.3 Registered Trademarks
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1
and Windows® 10 are registered trademarks of Microsoft Corporation.

EtherCAT® is a registered trademark of Beckhoff Automation GmbH, Verl,
Germany, formerly Elektro Beckhoff GmbH.

CODESYS® is a registered trademark of 3S-Smart Software Solutions
GmbH, Deutschland.

All other mentioned trademarks are property of their respective legal
owners.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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1.4 About EtherCAT Slave DTM

You can use the EtherCAT Slave DTM to configure EtherCAT Slave
devices within a FDT Framework and to view the device diagnosis.

In a network project the EtherCAT Slave DTM can be dropped:
e to the root line (Stand-Alone Slave),
e or to the Master busline of a EtherCAT Master DTM.

Slave DTM at the Root-Line (Stand-Alone Slave)

Insert the EtherCAT Slave DTM to the root busline if you intend to configure
only one single EtherCAT Slave device.

Slave DTM at the Master Busline

Insert the EtherCAT Slave DTM to the Master busline of the EtherCAT
Master DTM if within the network project the Slave device and the Master
device are used, i. e. if you intend to configure the Slave device and the
Master device.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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141 Requirements

System Requirements

e PC with 1 GHz processor or higher

e Windows® XP SP3,
Windows® Vista (32 bit) SP2,
Windows® 7 (32 bit und 64-Bit) SP1,
Windows® 8 (32-Bit und 64-Bit),
Windows® 8.1 (32-Bit und 64-Bit),
Windows® 10 (32-Bit und 64-Bit)

e Administrator privilege required for installation

e Internet Explorer 5.5 or higher

¢ RAM: min. 512 MByte, recommended 1024 MByte
e Graphic resolution: min. 1024 x 768 pixel

e Keyboard and Mouse

e Restriction: Touch screen is not supported.

Note: If the project file is used on another PC,
= the other PC must also comply to these system requirements,

= the device description files of the devices used in the project must be
imported to the configuration software SYCON.net on the other PC,

= respectively the DTMs of the devices used in the project must be
installed on the other PC.

Requirements EtherCAT Slave DTM

To configure the EtherCAT Slave device with the EtherCAT Slave DTM the
following requirements have to be accomplished:

e Completed hardware installation of a netX based DTM-compatible
EtherCAT Slave device, inclusive loaded firmware and loaded
configuration file

¢ Installed FDT/DTM V 1.2 compliant frame application

¢ Installed EtherCAT Master DTM (If Slave DTM is dropped to the Master
busline.)

e Loaded DTM in the Device Catalog of the FTD Framework

Note: If the EtherCAT Slave DTM and the EtherCAT Slave device are
installed on the same PC, the cifX Device Driver must be installed on
that PC, as you can connect the DTM to the device.

For more information to the hardware installation, please refer to the
corresponding User Manual of your device.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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1.5 Dialog Structure of the EtherCAT Slave DTM

The graphical user interface of the DTM is composed of different areas and
elements listed hereafter:

1.

AN A

A header area containing the General Device Information,
The Navigation Area (area on the left side),

The Dialog Pane (main area on the right side),

OK, Cancel, Apply, Help,

The Status Line containing information e. g. the online-state of the
DTM.

General Device Information

Navi
gation
Area

Dialog Pane

OK Cancel Apply Help

Status Line

Figure 1: Dialog Structure of the EtherCAT Slave DTM

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
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151 General Device Information

Parameter

Meaning

10 Device

Name of the device

Vendor

Vendor name of the device

Device ID

Identification number of the device

Vendor ID

Identification number of the vendor

Table 3: General Device Information

152 Navigation Area

The Navigation Area contains folders and subfolders to open the dialog

panes of the DTM.

Navigation Area

Settings
= Driver
Device Assignment
Firmware Download
Configuration

Figure 2: Navigation Area

B

» Select the required folder and subfolder.

2 The corresponding Dialog pane is displayed.

Hide / display Navigation

(=] | Hiding the navigation area (above right side).

@ Show navigation area

Opening the navigation area (below left side).
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153 Dialog Panes
At the dialog pane the Settings, Configuration, Diagnosis/Extended
Diagnosis or the Tools panes are opened via the corresponding folder in
the navigation area.
Settings
Driver To establish a connection from the EtherCAT Slave DTM to the EtherCAT Slave

device, on the pane Driver you can verify if the default driver is checked and
respectively check another driver or multiple drivers. For further information, refer to
section Driver on page 35.

Device Assignment

On the pane Device Assignment you select the device and assign the device to the
driver. For further information, refer to section Device Assignment on page 45.

Firmware Download

The dialog on the pane Firmware Download is used to load a new firmware into the
device. A detailed description can be found in section Firmware Download on page 51.

Configuration

Configuration At the Configuration pane Configuration you can perform the basic configuration tasks
for the EtherCAT Slave device.
General At the General pane EtherCAT Slave information is displayed. For further information,

refer to section General on page 62.

General Settings

The General Settings pane displays the most important general settings.

Extended Diagnosis

Behavior At the Behavior pane the parameters of the Device checkup, the Process Data and the
Watchdog are described. For further information, refer to section Behavior on page 69.
Mailbox At the Mailbox pane you can get information on mailbox-based data transfer and the
CoE (CANopen over Ethernet) functionality. For further information, refer to section
Mailbox on page 76.
Diagnosis
Diagnosis/ At the Diagnosis panes information can be read for troubleshooting. For further

information, refer to section Overview Diagnosis on page 84 and section Overview
Extended Diagnosis on page 88.

Tools
Packet Monitor/ Under Tools the Packet Monitor and the 10 Monitor are provided for test and diagnosis
10 Monitor purposes. For further information, refer to section Packet Monitor on page 97 or section

10 Monitor on page 100.

Table 4: Overview Dialog Panes

requires an online connection from the EtherCAT Slave DTM to the

EtherCAT Slave DTM.

Note: Accessing the Diagnosis panes of the EtherCAT Slave DTM

£\ For further information, refer to section Connecting/Disconnecting Device
'- |I| ' on page 80.
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1.5.4 OK, Cancel, Apply and Help

OK, Cancel, Apply and Help you can use as described hereafter.

Meaning

OK To confirm your latest settings, click OK. All changed values will be applied on the frame application
database.
The dialog then closes.

Cancel To cancel your latest changes, click Cancel.

Answer to the safety query Configuration data has been changed. Do you want to save the data?
by Yes, No or Cancel.

Yes: The changes are saved or the changed values are applied on the frame application database.
The dialog then closes.

No: The changes are not saved or the changed values are not applied on the frame application
database.
The dialog then closes.

Cancel: Back to the DTM.

Apply To confirm your latest settings, click Apply. All changed values will be applied on the frame application
database.
The dialog remains opened.

Help To open the DTM online help, click Help.
Table 5: OK, Cancel, Apply and Help

155 Table Lines

In the DTM dialog pane table lines can be selected, inserted or deleted.

Meaning

4 To select the first line of a table use First Line.

To select the previous line of a table use Previous Line.

To select the next line of a table use Next Line.

b To select the last line of a table use Last Line.

Create a new Line inserts new lines into the table.

Delete selected Line deletes the selected line from the table.

FEFFE

Table 6: Selecting, inserting, deleting Table Line
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1.5.6 Status Bar

The Status Bar displays information about the current state of the DTM.
The current activity, e.g. download, is signaled graphically via icons in the

status bar.
=1[= Disconnected O Daba Set
1 2 3456
Figure 3: Status Bar — Status Fields 1 to 6
Status | Icon /Meaning
Field
1 DTM Connection States
ﬂf Connected: Icon closed = Device is online
<Jp= | Disconnected: Icon opened = Device is offline
2 Data Source States
[] Data set: The displayed data are read out from the instance data set
(database).
_['B_ Device: The displayed data are read out from the device.
3 States of the instance Date Set
/ Valid Modified: Parameter is changed (not equal to data source).
4 Changes directly made on the Device
'@ Load/configure diagnosis parameters: Diagnosis is activated.
6 Device Diagnosis Status
] Save operation succeeded: The save operation has been successful.
Further messages due to successful handling of device data.
@ Firmware Download: Firmware Download is running
@ Save operation failed: The save operation has failed.
Further fail operation messages due to incorrect communication due to
malfunction in the field device or its peripherals.

Table 7: Status Bar Icons [1]

Offline State

Save operation
succeeded

Firmware Download

Firmware Download
successful

Online State and
Diagnosis

2)l= Disconnected () Data Set

<)0= Disconnected | [ Data Set f sl |5awe operation succeeded
= Discannected [ Data Set (1 Firmware Dawnload

<)l= Disconnected [ Data Set |seall

ﬂ&: Connected i Cevice L

Figure 4: Status Bar Display Examples
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2 Safety
2.1 General Note

The documentation in the form of a user manual, an operating instruction
manual or other manual types, as well as the accompanying texts have
been created for the use of the products by educated personnel. When
using the products, all Safety Messages, Integrated Safety Messages,
Property Damage Messages and all valid legal regulations must be obeyed.
Technical knowledge is presumed. The user has to assure that all legal
regulations are obeyed.

2.2 Intended Use

The EtherCAT Slave DTM serves for configuration and diagnosis of
EtherCAT Slave devices.

2.3 Personnel Qualification

Personnel responsible for the application of the network system shall be
aware of the system behavior and shall be trained in using the system.
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2.4 Personal Injury

To ensure your own personal safety and to avoid personal injury, you
necessarily must read, understand, and comply with the safety instructions
and safety messages in this manual before you configure your system.

24.1 Communication Stop

If you perform a firmware download or a configuration download via the
EtherCAT Slave DTM be aware of the following:

Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established
connections will drop.

If you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.

Unexpected equipment operation may cause personal injury.

Stop the application program before starting upgrading the firmware or
downloading the configuration.

Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before upgrading the firmware or downloading a configuration.

You find the description about the firmware download in section Firmware
Download on page 51 and about the configuration download in section
Download Configuration on page 82.

2.4.2 Mismatching System Configuration

Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause personal injury.
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2.5 Property Damage

To avoid property damage respectively device destruction and damage to
your system or to your equipment, you necessarily must read, understand,
and comply with the safety instructions and safety messages in this manual
before you configure your system.

2.5.1 Communication Stop

If you perform a firmware download or a configuration download via the
EtherCAT Slave DTM be aware of the following:

Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established
connections will drop.

If you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.

Damage of Equipment

Unexpected equipment operation may cause property damage.

Stop the application program before starting upgrading the firmware or
downloading the configuration.

Make sure that your equipment operates under conditions that prevent
property damage. All network devices should be placed in a fail-safe
mode before upgrading the firmware or downloading a configuration.

Loss of Device Parameters

Both the firmware download and the configuration download erase the
configuration data base. The firmware download overwrites the existing
firmware in the network device.

Device parameters that have not been saved non-volatile are getting lost
during the reset.

To complete the firmware update and to make the device operable
again, re-download the configuration when the firmware update has
been finished.

25.2 Invalid Firmware

Loading invalid firmware files could render your module unusable.

2.5.3 Mismatching System Configuration

Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause damage of equipment.
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2.6 Labeling of Safety Messages
e The Section Safety Messages at the beginning of a chapter are
pinpointed particularly and highlighted by a signal word according to the
degree of endangerment. The kind of danger is specified exactly by the
safety message text
e The Integrated Safety Messages within an instruction description are
highlighted with a signal word according to the degree of endangerment.
The kind of danger is specified exactly by the safety message text.
Signal Word Meaning (international) Meaning (USA)
Indicates a direct hazard with high risk, which Indicates a Hazardous Situation Which if not
will have as consequence death or grievous Avoided, will Result in Death or Serious Injury.
bodily harm if it isn't avoided.
Indicates a possible hazard with medium risk, Indicates a Hazardous Situation Which if not
which will have as consequence death or Avoided, could Result in Death or Serious
(grievous) bodily harm if it isn't avoided. Injury.
Indicates a minor hazard with medium risk, Indicates a Hazardous Situation Which if not
which could have as consequence simple Avoided, may Result in Minor or Moderate
battery if it isn't avoided. Injury.
Table 8: Signal Words in Safety Messages on Personal Injury
Signal Word Meaning (international and USA)
NOTICE Indicates a Property Damage Message.
Table 9: Signal Words in Safety Messages on Property Damage
In this document all Safety Instructions and Safety Messages are designed
according both to the international used safety conventions as well as to
the ANSI Z535.6 standard, refer to reference safety [S1].
In this document the signal words ‘WARNING’, ‘CAUTION' and ‘NOTICE' are used
according to ANSI Z535.6 standard. The meaning given in ISO/IEC 26514 [S4] section
‘11.11 Contents of warnings and cautions’ is not relevant in this manual.
2.7 References Safety

[S1] ANSI z535.6-2006 American National Standard for Product Safety Information in
Product Manuals, Instructions, and Other Collateral Materials

[S4] 26514-2010 - IEEE Standard for Adoption of ISO/IEC 26514:2008 Systems and
Software Engineering--Requirements for Designers and Developers of User

Documentation
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3 Getting started

3.1 Configuration Steps
The following overview provides to you the step sequence on how to
configure a netX based EtherCAT Slave device with EtherCAT Slave DTM
as it is typical for many cases. At this time it is presupposed that the
hardware installation was done.
The overview lists all the steps in a compressed form. For detailed
descriptions of each step refer to the sections noted in the column For
detailed information see section.
The following two cases are considered:
e Slave DTM at the Root-Line (Stand-Alone Slave)
¢ and Slave DTM at the Master busline.
3.1.1 Slave DTM at the Root-Line (Stand-Alone Slave)
# Step Short Description For detailed Page
information see section
1 Load device Depending of the FDT Container: -
catalog For netDevice: (See Operating
- select Network > Device Catalog, Instruction Manual
- select Reload Catalog. netDevice and
netProject)
2 Create new Depending of the frame application. (See Operating -
project / Open For the configuration software: Instruction Manual of the
existing project - select File > New or File > Open. Frame Application)
3 Insert Slave into Depending of the FDT Container: -

configuration

For netDevice:

- in the Device Catalog under Gateway / Stand-
Alone Slave click to the Slave,

- and insert the Slave via drag and drop

to the root line in the network view.

(See Operating
Instruction Manual
netDevice and
netProject)

4 Open the Slave
DTM configu-
ration dialog

Open the Slave DTM configuration dialog.
- Double click to the device icon of the Slave.

- The Slave DTM configuration dialog is displayed.
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# Step

Short Description

For detailed
information see section

Page

5 Verify or adapt
Driver Settings

In the Slave DTM configuration dialog:
- select Settings > Driver.

e Note! For PC cards cifX the cifX
Device Driver is preset as a default

driver. For all the other Hilscher devices
the netX Driver is preset as a default
driver.Use the cifX Device Driver if the
EtherCAT Slave DTM is installed on the
same PC as the EtherCAT Slave
device.

e Use the netX Driver to establish a
USB, Serial (RS$232) or TCP/IP
connection from the EtherCAT Slave
DTM to the EtherCAT Slave device.

e The 3SGateway Driver for netX (V3.x)
is used only in relationship with
CODESYS.

To search for devices you can check one
or multiple drivers simultaneously.

- Verify that the default driver is checked.
- If necessary, check another driver or multiple
drivers.

Settings for Driver and
Device Assignment
and

Driver

33

35

6 Configure Driver

If you use the netX Driver, you respectively must
configure it.

For netX Driver and communication via TCP/IP
set the IP address of the device:

- Select Settings > Driver > netX Driver > TCP
Connection.

-via[tl add an 1P range.

- Under IP Address enter the IP Address of the
device or an IP range.

- Click Save.

Adjust the driver parameters netX Driver
USB/RS232 only if they differ from the default
settings.

a Note!
e The cifX Device Driver requires no

configuration.

e The configuration of the 3SGateway
Driver for netX (V3.x) is carried out via
the CODESYS surface.

Configuring netX Driver

38

7 Assign Slave
device (with or
without
firmware)

Assign the device to this driver.

In the Slave DTM configuration dialog:

- select Settings > Device Assignment,

- select a Slave device (with or without firmware),
- therefore check the appropriate checkbox,

- select Apply.

Selecting the Device
(with or without firmware)

48

8 Select and
download
firmware

If not yet a firmware was loaded to the device:

- Adhere to the necessary safety precautions to
prevent personnel injury and property damage that
may occur in consequence of a communication
stop.

In the Slave DTM configuration dialog:

- select Settings > Firmware Download,
- select Browse..,

- select a firmware file,

- select Open,

- select Download and Yes.

Safety Messages on
Firmware or
Configuration Download

Firmware Download

30

51
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# Step

Short Description

For detailed
information see section

Page

9 Assign Slave
device once
more (with
firmware and
system chanal)

For repeated
download this
step is omitted.

In the Slave DTM configuration dialog:

- select Settings > Device Assignment,

- select Scan,

- select the Slave device (with loaded firmware and
defined system channel),

- therefore check the appropriate checkbox,

- select Apply,

- close the Slave DTM configuration dialog via OK.

Selecting the Device
once more (with
Firmware)

49

10 Configure Slave
device

Configure the Slave device.

- Double click to the device icon of the Slave.

- The Slave DTM configuration dialog is displayed.
In the Slave DTM configuration dialog:

- select Configuration >General Settings,

- set the Device Settings.

- close the Slave DTM configuration dialog via OK.

Configuring Slave
Parameter

General Settings

60

63

11 Save project

Depending of the frame application.
For the configuration software:
- select File > Save.

(See Operating
Instruction Manual of the
Frame Application)

12 Connect Slave
device

Depending of the FDT Container.

For netDevice:

- right click to the device icon of the Slave,
- select Connect.

Connecting/Disconnecting
Device

80

13 Download
Configuration

- Adhere to the necessary safety precautions to
prevent personnel injury and property damage that
may occur in consequence of a communication stop
or in consequence of a mismatching system
configuration.

Depending of the FDT Container.

For netDevice:

- right click to the device icon of the Slave,
- select Download.

Safety Messages on
Firmware or
Configuration Download

Download Configuration

30

82

14 Diagnosis

Depending of the FDT Container.

For netDevice:

- right click to the device icon of the Slave,

- select Diagnosis.

- The Slave DTM diagnosis dialog is displayed.

(1) Check whether the communication is OK:
Diagnosis > General Diagnosis > Device status
"Communication" must be green!

(2) ,Communication“ is green: Open thel IO
Monitor and test the input or output data.

(3) ,Communication“ is not green: Use Diagnosis
and Extended diagnosis for troubleshooting.

- close the Slave DTM diagnosis dialog via OK.

Overview Diagnosis

84

15 10 Monitor

Depending of the FDT Container:

For netDevice:

- right click to the device icon of the Slave,
- select Diagnosis,

- select Tools > 10 Monitor.

- Check the input or output data,

- close the 10 Monitor dialog via OK.

10 Monitor

100

16 Disconnect

Depending of the FDT Container.

For netDevice:

- right click to the device icon of the Slave,
- select Disconnect.

Connecting/Disconnectin
g Device

80

Table 10: Getting Started - Configuration Steps (Slave DTM at the Root-Line (Stand-Alone

Slave))
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3.1.2 Slave DTM at the Master Busline

#

Step

Short Description

For detailed information
see section

Page

Load device
catalog

Depending of the FDT Container:
For netDevice:

- select Network > Device Catalog,
- select Reload Catalog.

(See Operating Instruction
Manual netDevice and
netProject)

Create new
project / Open
existing project

Depending of the frame application.
For the configuration software:
- select File > New or File > Open.

(See Operating Instruction
Manual of the Frame
Application)

Insert Master or
Slave into
configuration

For netDevice:

- in the Device Catalog click to the Master,
- and insert the device via drag and drop

to the root line in the network view,

- in the Device Catalog click to the Slave,

- and insert the device via drag and drop

to the Master bus line in the network view.

(See Operating Instruction
Manual netDevice and
netProject)

Open the Slave
DTM configu-
ration dialog

Open the Slave DTM configuration dialog.
- Double click to the device icon of the Slave.
- The Slave DTM configuration dialog is displayed.

Verify or adapt
Driver Settings

In the Slave DTM configuration dialog:
- select Settings > Driver.

Driver is preset as a default driver. For all
the other Hilscher devices the netX
Driver is preset as a default driver.

.a Note! For PC cards cifX the cifX Device

e Use the cifX Device Driver if the
EtherCAT Slave DTM is installed on
the same PC as the EtherCAT Slave
device.

e Use the netX Driver to establish a
USB, Serial (RS232) or TCP/IP
connection from the EtherCAT Slave
DTM to the EtherCAT Slave device.

e The 3SGateway Driver for netX
(V3.x) is used only in relationship with
CODESYS.

To search for devices you can check one
or multiple drivers simultaneously.

- Verify that the default driver is checked.
- If necessary, check another driver or multiple
drivers.

Settings for Driver and
Device Assignment
and

Driver

33

35

Configure Driver

If you use the netX Driver, you respectively must
configure it.

For netX Driver and communication via TCP/IP
set the IP address of the device:

- Select Settings > Driver > netX Driver > TCP
Connection.

-via[tl add an IP range.

- Under IP Address enter the IP Address of the
device or an IP range.

- Click Save.

Configuring netX Driver

38
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# Step Short Description For detailed information | Page
see section
6 Configure Driver | Adjust the driver parameters netX Driver
(continued) USB/RS232 only if they differ from the default Configuring netX Driver 38
settings.
a Note!
e The cifX Device Driver requires no
configuration.
e The configuration of the 3SGateway
Driver for netX (V3.x) is carried out via
the CODESYS surface.
7 Assign Slave Assign the device to this driver. Selecting the Device (with | 48
device (with or In the Slave DTM configuration dialog: or without firmware)
without - select Settings > Device Assignment,
firmware) - select a Slave device (with or without firmware),
- therefore check the appropriate checkbox,
- select Apply.
8 Select and If not yet a firmware was loaded to the device:
;J_Iownload - Adhere to the necessary safety precautions to Safety Messages on 30
Irmware prevent personnel injury and property damage that | Firmware or Configuration
may occur in consequence of a communication Download
stop.
In the Slave DTM configuration dialog: Firmware Download 51
- select Settings > Firmware Download,
- select Browse..,
- select a firmware file,
- select Open,
- select Download and Yes.
9 Assign Slave In the Slave DTM configuration dialog: Selecting the Device once | 49
device once - select Settings > Device Assignment, more (with Firmware)
more (with - select Scan,
firmware and - select the Slave device (with loaded firmware and
system chanal) defined system channel),
For repeated - therefore check the appropriate checkbox,
download this - select Apply, . . .
stevg\; is omittled - close the Slave DTM configuration dialog via OK.
10 | Configure Slave | Configure the Slave device. Configuring Slave 60
device - Double click to the device icon of the Slave. Parameter
- The Slave DTM configuration dialog is displayed.
In the Slave DTM configuration dialog:
- select Configuration >General Settings, General Settings 63
- set the Device Settings.
- select Configuration >Behavior, Behavior 69
- set the Behavior.
- select Configuration >Mailbox->CoE, CoE 76
- set the CoE Settings.
- close the Slave DTM configuration dialog via OK.
11 | Configure Configure the Master device via the EtherCAT (See Operating Instruction | -
Master device Master DTM netX. Manual DTM for
EtherCAT Master
devices)
12 Save project Depending of the frame application. -
For the configuration software: (See Operating Instruction
- select File > Save. Manual of the Frame
Application)
13 | Connect Slave Depending of the FDT Container. Connecting/Disconnecting | 80

device

For netDevice:
- right click to the device icon of the Slave,
- select Connect.

Device
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#

Step

Short Description

For detailed information
see section

Page

14

Download
Configuration

- Adhere to the necessary safety precautions to
prevent personnel injury and property damage that
may occur in consequence of a communication stop
or in consequence of a mismatching system
configuration.

Depending of the FDT Container.

For netDevice:

- right click to the device icon of the Slave,
- select Download.

Safety Messages on
Firmware or Configuration
Download

Download Configuration

30

82

15

Diagnosis

Depending of the FDT Container.

For netDevice:

- right click to the device icon of the Slave,

- select Diagnosis.

- The Slave DTM diagnosis dialog is displayed.

(1) Check whether the communication is OK:
Diagnosis > General Diagnosis > Device status
"Communication" must be green!

(2) ,Communication“ is green: Open thel 1O
Monitor and test the input or output data.

(3) ,Communication“ is not green: Use Diagnosis
and Extended diagnosis for troubleshooting.

- close the Slave DTM diagnosis dialog via OK.

Overview Diagnosis

84

16

10 Monitor

Depending of the FDT Container:

For netDevice:

- right click to the device icon of the Slave,
- select Diagnosis,

- select Tools > 10 Monitor.

- Check the input or output data,

- close the 10 Monitor dialog via OK.

10 Monitor

100

17

Disconnect

Depending of the FDT Container.

For netDevice:

- right click to the device icon of the Slave,
- select Disconnect.

Connecting/Disconnecting
Device

80

Table 11: Getting Started - Configuration Steps (Slave DTM at the Master busline)
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3.2 Safety Messages on Firmware or Configuration Download

If you perform a firmware download or a configuration download via the
EtherCAT Slave DTM adhere to the necessary safety precautions to
prevent personnel injury and property damage that may occur in
consequence of a communication stop or in consequence of a mismatching
system configuration. Also invalid or non-authorized firmware can damage
your device.

Personnel Injury

| A WARNING |

Communication Stop

Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established
connections will drop.

If you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.
Unexpected equipment operation may cause personal injury.

Stop the application program before starting upgrading the firmware or
downloading the configuration.

Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before upgrading the firmware or downloading a configuration.

Mismatching System Configuration

Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause personal injury.

For more refere to next page.
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Property Damage

NOTICE

Communication Stop

= Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established
connections will drop.

= If you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.

Damage of Equipment
= Unexpected equipment operation may cause property damage.

= Stop the application program before starting upgrading the firmware or
downloading the configuration.

= Make sure that your equipment operates under conditions that prevent
property damage . All network devices should be placed in a fail-safe
mode before upgrading the firmware or downloading a configuration.

Loss of Device Parameters

= Both the firmware download and the configuration download erase the
configuration data base and overwrites the existing firmware in the
device.

= Device parameters that have not been saved non-volatile such as a
temporary IP address are getting lost during the reset.

= Before you initiate firmware or a configuration download make sure that
your project configuration data are saved non-volatile in order to prevent
loss of configuration data.

= To complete the update and to make the device operable again, please
re-download the configuration when this operation has finished.

Invalid or non-authorized Firmware

= Loading invalid or non authorized firmware files could render your
module unusable. Only proceed with a authorized firmware update.

Mismatching System Configuration

= Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause property damage.
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4 Settings

4.1 Overview Settings

Settings Dialog Panes

The table below gives an overview for the individual Settings dialog panes
descriptions:

EtherCAT Slave DTM Folder Name / Subsection Manual
Section Page
M avigation Area = Driver 35

Settings Verify or adapt Driver Settings 35

Ly Dirivver cifX Device Driver 37
Dev:-lcztisz:gner;ent netx Driver 37
Firrmware Download Configuring netX Driver 38
Navigation Area — Device Assignment 45
Settings (Example) Scanning for Devices 45
g‘iggiltzia(;/zzl drivers can be Scanning for all Devices or for suitable only 47
Selecting the Device (with or without firmware) 48

Selecting the Device once more (with Firmware) |49

Firmware Download 51

Table 12: Descriptions of the Dialog Panes Settings

Note: To edit the Settings dialog panes you need User Rights for
“Maintenance”.

Notice the descriptions in the section Settings for Driver and Device
Assignment on page 33.

To access to the online help with the descriptions of the drivers:
» Select Settings > Driver > [Name of the assigned driver].
» Press the F1 key.
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4.2 Settings for Driver and Device Assignment

The following steps are needed to establish a connection from the
EtherCAT Slave DTM to the EtherCAT Slave device:

Verifying or adapting Driver Settings

Verify the Driver Settings and adapt them if necessary.

1. Open the DTM configuration dialog.

> In the FDT container netDevice double click to the EtherCAT Slave
device icon.

2. Verify that the default driver is checked and respectively check another
or multiple drivers.

» Select Settings > Driver.

Note! For PC cards cifX the cifX Device Driver is preset as a default
driver. For all the other Hilscher devices the netX Driver is preset as a
default driver.

= Use the cifX Device Driver if the EtherCAT Slave DTM is installed on
the same PC as the EtherCAT Slave device.

= Use the netX Driver to establish an USB, Serial (RS232) or TCP/IP
connection from the EtherCAT Slave DTM to the EtherCAT Slave
device.

= The 3SGateway Driver for netX (V3.x) is used only in relationship with
CODESYS.

To search for devices on the network you can check one or multiple
drivers simultaneously.

» Verify that the default driver for your device is checked.

» If necessary, check another driver or multiple drivers.

Confiquring Driver

Note!

= The cifX Device Driver requires no configuration.
= The configuration of the 3SGateway Driver for netX (V3.x) is carried
out via the CODESYS surface.

If you use the netX Driver, you respectively must configure it.
3. Configure the netX Driver if necessary.

For the driver netXDriver an individual driver dialog window can be opened
where you can configure the driver.

» Select Settings > Driver > netX Driver.

> For netX Driver and communication via TCP/IP set the IP address of
the device.

Adjust the driver parameters netX Driver USB/RS232 only if they differ
from the default settings.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
DOC1107020I04EN | Revision 4 | English | 2017-03 | Released | Public © Hilscher, 2012-2017



Settings 34/125

Assigning the Slave device to the DTM

4. Scan for and select the devices (with or without firmware).
» Select Settings > Device Assignment.

» Under Device selection select suitable only or all and then Scan.
» In the table check the required devices.

» Select Apply.

Selecting and downloading the Firmware

o

If not yet a firmware was loaded to the device, select and download the
firmware.

Select Settings > Firmware Download.
Select and download the firmware via Download.
Select Apply.

© VvV V V

Scan for and select the devices (with firmware and defined system
channel) once more.

For repeated download this step is omitted.
Select Settings > Device Assignment.
Select Scan.

In the table check the required device.

NV VvV Vv

Close the DTM configuration dialog via OK.

Connecting the Device

8. In netDevice put a right-click on the EtherCAT Slave device icon.
9. Select the Connect command from the context menu.

> In the network view the device description at the device icon of the
Slave is displayed with a green colored background. The EtherCAT
Slave device now is connected to the EtherCAT Slave DTM via an
online connection.

Further Information

~ For descriptions about these steps refer to the sections following here-
| after.
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4.3 Driver

The Driver dialog pane displays the drivers to be used for a EtherCAT
Slave DTM to establish a device communication connection.

Note! A default driver is set in the configuration software.

Driver
| Driver Version | 1D
CIFX Device Driver 1,101.1.9801 {368BEC5B-0E92-4C0E-B4AS-6HF G ZAETAAFA}
[0  3sGateway Driver for netX (V3.x) 0.9.1.2 {787CD3A9-4CF6-4259-8E4D- 109BEASEEAS 1}
[0  net¥Oriver 1.103.2.5183 {B54CBCCTF333-4135-6405-6E 12FCE3EES 2}
Figure 5: Default Driver ,cifX Device Driver’ for PC cards cifX
Parameter Meaning
Driver Name of the driver (for more details see descriptions hereafter)
Version ODMV3 Version of the respective driver
ID ID of the driver (driver identification)

Table 13: Driver Selection List Parameters

To establish a connection from the EtherCAT Slave DTM to the EtherCAT
Slave device, verify if the default driver is checked and respectively check
another driver or multiple drivers.

4.3.1 Verify or adapt Driver Settings

Proceed as follows:
1. Select Settings > Driver in the navigation area.

2 The Driver dialog pane is displayed with the available drivers and the
setting for the default driver.

Driver
| Driver | Versian | 1D
CIFX Device Driver 1,.101.1,9801 {368BECSB-0ES 2-4C0E-B4A-64F6 2AETAAFA}
O 35Gateway Driver for nety (V3.x) 0.9.1.2 {787CD3A9-4CF6-4259-8E40- 109B6AGBEAT 1}
O net Driver 1.103.2,5183 {B54CaCCTF333-4135-8405-6E 1 2FCBBEER T}

Figure 6: Default Driver ,cifX Device Driver’ for PC cards cifX (example)

Driver
| Driver Version | 1D
I:I CIFX Device Driver 1.101.1.9801 {368BECSB-0ES 2-4C0E-B4A-64F 5 2AETAAFA}
D 35Gateway Driver for net¥ (V3.x) 0.9.1.2 {787C03A9-4CF6-4259-5E4D- 109B6ACBEAD 1}
netX Driver 1.103.2.5183 {B54CaCCTF333-4135-8405-6E 1 2FCBBEEA 2}

Figure 7: Default Driver ,netX Driver for Hilscher devices except for PC cards cifX (example)

2. Verify that the default driver is checked.

» Verify that the default driver for your device is checked.
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Default Driver (Pre-settings in the Configuration Software): For PC cards
cifX the cifX Device Driver is preset as a default driver. For all the other
Hilscher devices the netX Driver is preset as a default driver.

3. Respectively check another driver.

Note! The driver used for the connection from the EtherCAT Slave DTM
to the EtherCAT Slave device must be supported by the device and must
be available for the device.

e Use the cifX Device Driver if the EtherCAT Slave DTM is installed on
the same PC as the EtherCAT Slave device.

o Use the netX Driver to establish a USB, Serial (RS232) or TCP/IP
connection from the EtherCAT Slave DTM to the EtherCAT Slave
device.

¢ The 3SGateway Driver for netX (V3.x) is used only in relationship with
CODESYS. The version V3.x refers to the driver version defined by 3S-
Smart Software Solutions GmbH.

» Check the checkbox for the driver in the selection list.

4. Respectively check multiple drivers.

To search for devices on the network you can check multiple drivers
simultaneously.

Driver

| Driver

| Version | 1D

CIFX Device Driver
D 35Gateway Driver for net (V3.x) 0.9.1.2 {787C03A9-4CF6-4259-58E4D-109B6AGBEAS 1}
nety Driver

1,101.1.9801 {368BECSB-0E92-4C0E-B4AT-69F 6 2AETAAFA}
1.103.2.5183 {B54CBCC7-F333-4135-8405-0E12FCBBEEG 2}

Figure 8: Manual Selection of multiple drivers (Example)
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4.3.2 cifX Device Driver

In the EtherCAT Slave-DTM for the cifX Device Driver no driver dialog
pane is available, since for the cifX Device Driver no driver settings are
required.

The cifX Device Driver will be used if the EtherCAT Slave DTM is installed
in the same PC as the EtherCAT Slave device.

Note: To establish a connection from a DTM to a Slave device via the
cifX Device Driver, the cifX Device Driver must be installed and the
driver must have access to the Slave device.

4.3.3 netX Driver

The netX Driver is used to connect the DTM to the device via different
connection types. The DTM communicates with the device via an USB
connection, a serial (RS232) connection or a TCP/IP connection. The netX
Driver establishes

e via the USB interface of the device and the USB port of the PC an USB
connection to the device,

¢ via the RS232 interface of the device and the COM port of the PC a
serial connection (RS232) to the device

e and via Ethernet a TCP/IP connection to the device.

To connect the DTM to the physical layer of the device the netX Driver
software works in combination with the software components:

e “USB/COM connector” for the USB connection and for the serial
connection (RS232) and

e “TCP/IP connector” for the Ethernet connection.
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4.3.4 Configuring netX Driver

The following steps are required to configure the netX Driver:

USB/RS232 Connection

To set the driver parameters for an USB/RS232 connection note:

Note: Adjust the driver parameters netX Driver USB/RS232 only if they
differ from the default settings. After saving the changed driver
parameters, these parameters are used for the device assignment when
scanning devices.

For setting the driver parameters for an USB connection or a serial
connection:

1. Select Settings > Driver > netX Driver > USB/RS232 Connection.
» Set the driver netX Driver USB/RS232 parameters.

TCP/IP Connection

For setting the driver parameters for a TCP/IP connection:

1. Select Settings > Driver > netX Driver > TCP Connection.
Set IP Address of the device:

2
» Add an IP Range via Select IP Range D
3

Under IP Range Configuration > IP Address enter the IP Address of
the device (Use IP Range is unchecked).

Set IP Range:
Check Use IP Range.

» Under IP Range Configuration > IP Address enter the start address
(left side) and the ending address of the IP scanning range (right side).

5. Click Save, to save the IP address or the IP range.

R After saving the changed driver parameters, these parameters are used
for the device assignment when scanning devices.
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4.3.5 netX Driver - USB/RS232 Connection

The communication from the DTM to the device via an USB/RS232
Connection is used when the DTM is installed on a PC and between the
PC and the device

e an USB connection

e or a serial connection (RS232) exists.

The DTM accesses the device via the USB interface or via the RS232
interface. This requires either to connect an USB port of the PC to the USB

interface of the device using an USB cable or to connect a physical COM
port of the PC to the RS232 interface of the device via a serial cable.

The netX Driver / USB/RS232 Connection supports all physical and
virtual COM ports available on the PC.

Via the RS232 interface or USB interface, the device is configured or
diagnosis is performed.
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4351

Driver Parameters for netX Driver - USB/RS232 Connection

The settings of the driver parameters for the USB/RS232 connection are
made via the netX Driver / USB/RS232 Connection configuration dialog.

» Open the USB/RS232 Connection dialog via navigation area Settings
> Driver > netX Driver.

2 The USB/RS232 Connection dialog is displayed:

USE/RS232 Connection | TCP Connection |

[v Enable USE/R3232 Connector (Restart of QDM required)

[COM1 |

Port Configuration
[ Disable Port

Select Part:

BaudRate:  |115.2 kaitjs | Byte Size: |5 Biyte

El

Skop Bits: Parity:

|1 Stopbit |

Send Timeouk: | 1000 i‘ s
Reset Timeout: | 10000 i‘ ms

|N|:| Paritw

Keep Alive Timeouk: | 2000 i‘ s

El

Reskore Save

| Save All |

Figure 9: netX Driver > USB/RS232 Connection

Parameter Meaning

Range of Value /
Default Value

Enable USB/RS232
Connector (Restart of
ODM required)

checked: The netX Driver can communicate via the
USB/RS232 interface.

unchecked: The netX Driver can not communicate via the
USB/RS232 interface.

If the check mark for Enable USB/RS232 Connector is set
or removed, then the ODM server must be restarted?, to
make the new setting valid.

1 Restart the ODM server via the ODMV3 Tray Application:

-In the foot line click on m using the right mouse key.
- In the context menu select Service > Start.

checked,
unchecked;
Default:
unchecked

Select Port Depending on the COM ports (interfaces) available on the

PC, they will be listed under Select Port.

COM1to COMN

Port Configuration

The device must support the baud rate.

Disable Port checked: No connection. checked,
unchecked: The netX Driver tries to establish a connection unchecked (Default)
using the configured USB/RS232 interface.

Baud rate Transfer rate: number of bits per second. 9.6, 19.2,38.4, 57.6 or

115.2 [kBit/s];
Default (RS232): 115.2
[kBit/s]
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Parameter Meaning Range of Value /
Default Value
Stop bits Number of stop bits sent after the transfer of the send data Stop bit: 1, 1.5, 2;

for synchronization purposes to the receiver.

Default (RS232): 1

Send Timeout

Maximum time before the transfer of the transmission data is
canceled, when the send process fails, for example, because
of the transfer buffer is full.

100 ... 60.000 [ms];
Default (RS232 and
USB): 1000 ms

Reset Timeout

Maximum time for a device reset, including the re-
initialization of the physical interface used for the
communication.

100 ... 60.000 [ms];
Default (RS232 and
USB): 5000 ms

Byte size Number of bits per byte by byte specification 7 Bit, 8 Bit;
Default (RS232): 8 Bit

Parity In the error detection in data transmission using parity bits, No Parity,

"parity" describes the number of bits occupied with 1 in the Odd Parity,

transmitted information word. Even Parity,

No Parity: no parity bit Mark Parity,

Odd Parity: The parity is "odd" if the number of bits occupied | Space Parity;

with 1 in the transmitted information word will be odd. Default (RS232):

Even parity: The parity is "even" if the number of bits No Parity

occupied with 1 in the transmitted information word will be
even.

Mark Parity: if the parity bit is always 1, this will be named
mark-parity (the bit does not contain any information).
Space Parity: if the parity bit always 0, this will be named
space-parity (the bit represents an empty space).

Keep Alive Timeout

The "Keep Alive" mechanism is used to monitor whether the
connection to the device is active. Connection errors are
detected using a periodic heartbeat mechanism. The
heartbeat mechanism will be initiated after the set time has
elapsed if the communication has failed.

100 ... 60.000 [ms];
Default (RS232 and
USB): 2000 ms

Restore Resets all settings in the configuration dialog to the default
values.

Save Saving all settings made in the configuration dialog netX
Driver > Save USB/RS232 Connection, i. e. only for the
selected connection type.

Save All Saving all settings made in the configuration dialog netX

Driver, i. e. for all connection types.

Table 14: Parameters netX Driver > USB/RS232 Connection
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4.3.6 netX Driver - TCP/IP Connection

The communication from the DTM to the device via a TCP/IP Connection
is used in the following two typical applications:

Application 1: The device has its own Ethernet interface. The DTM is
installed on a PC and the TCP/IP connection is established from this PC to
the stand-alone device. The IP address of the device is used.

Application 2: The device is installed in a remote PC. The DTM is installed
on an additional PC and the TCP/IP connection is established from this PC
to the remote PC. The IP address of the remote PC is used. For the TCP/IP
connection is made, on the remote PC the cifX TCP/IP server must be
started. The cifX TCP/IP server allows the remote access to the device via
a TCP/IP connection.

_) Note: An exe file for the cifXTCP/IP server is provided on the product CD
in the Tools directory.

Via the TCP/IP interface of the device or of the remote PC, the device is
configured or diagnosis is performed.
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4.3.6.1 Driver Parameters for netX Driver - TCP/IP Connection

The settings of the driver parameters for the TCP/IP connection are made
via the netX Driver / TCP Connection configuration dialog.

» Open the TCP Connection dialog via navigation area Settings >

Driver > netX Driver.
 The dialog netX Driver is displayed:
» Select TCP Connection.

USB{RS232 Connection  TCP Connection ]

[ Enable TCP Connector {Restart of QDM required)

Select IP Range: |IP_R.|:|.NGE|:| ﬂ = Sican Timeout: | 100

IP Range Configuration
[ Disable IP Range

IP Address [ Use IP Range TCP Port #ddress Count

.
:lms
L

|192.168. 1.1 —| i |s0111 |1

Send Timeouk; | 1000 :‘ ms Keep Alive Timeout: |2EIEIEI :l ms

Reset Tirmeouk: | 20000 :‘ s

Restore Save

| Save Al |

Figure 10: netX Driver > TCP Connection

Parameter Meaning

Range of Value /
Default Value

Enable TCP Connector checked: The netX Driver can communicate via the TCP/IP
(Restart of ODM interface.

required) unchecked: The netX Driver can not communicate via the
TCP/IP interface.

If the check mark for Enable TCP Connector is set or
removed, then the ODM server must be restarted?, to make
the new setting valid.

1 Restart the ODM server via the ODMV3 Tray Application:

-In the foot line click on m using the right mouse key.
- In the context menu select Service > Start.

checked,
unchecked;
Default:
unchecked

Select IP Range Via Select IP Range already created IP ranges can be
selected.

Via |:| an additional IP range can be added.

Via L2z an IP range can be deleted.
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Parameter

Meaning

Range of Value /
Default Value

Scan Timeout [ms]

With Scan Timeout can be set, how long to wait for a
response while a connection is established.

10 ... 10000 [ms];
Default: 100 ms

IP Range Configuration

Disable IP Range

checked: No connection.

unchecked: The netX Driver tries to establish a connection
using the configured TCP/IP interface.

checked,
unchecked (Default)

IP Address (left)

Enter the IP address of the device, (if Use IP Range is not
checked).

Enter the start address of the IP scanning range, (if Use IP
Range is checked).

valid IP address;
Default: 192.168.1.1

Use IP Range

checked: An IP address range is used.
unchecked: Only one IP address is used.

checked,
unchecked;
Default:
unchecked

IP Address (right)

Enter the ending address of the IP scanning range, (only if
Use IP Range is checked).

valid IP address;
Default: 0.0.0.0

Address Count

Displays the scanning range address count, depending on
the selected IP-start or IP-end address. (For this read the
note given below.)

recommended: 10

TCP Port

Identifies the endpoint of a logical connection or addresses a
specific endpoint on the device or PC.

0 - 65535;
Default Hilscher device:
50111

Send Timeout [ms]

Maximum time before the transfer of the transmission data is
canceled, when the send process fails, for example, because
of the transfer buffer is full.

100 ... 60.000 [ms];
Default (TCP/IP): 1000
ms

Reset Timeout [ms]

Maximum time for a device reset, including the re-
initialization of the physical interface used for the
communication.

100 ... 60.000 [ms];
Default (TCP/IP): 2000
ms

Keep Alive Timeout
[ms]

The "Keep Alive" mechanism is used to monitor whether the
connection to the device is active. Connection errors are
detected using a periodic heartbeat mechanism. The
heartbeat mechanism will be initiated after the set time has
elapsed if the communication has failed.

100 ... 60.000 [ms];
Default (TCP/IP): 2000
ms

Restore Resets all settings in the configuration dialog to the default
values.

Save Saving all settings made in the configuration dialog netX
Driver > Save TCP/IP Connection, i. e. only for the selected
connection type.

Save All Saving all settings made in the configuration dialog netX

Driver, i. e. for all connection types.

Table 15: Parameters netX Driver > TCP Connection

Note: Do not use large IP ranges in combination with a low scan timeout. Microsoft
introduced in Windows® XP SP2 a limit of concurrent half-open outbound
TCP/IPconnections (connection attempts) to slow the spread of virus and malware from
system to system. This limit makes it impossible to have more than 10 concurrent half-
open outbound connections. Every further connection attempt is put in a queue and
forced to wait. Due to this limitation a large IP range used in combination with a low scan

timeout could prevent the connection establishment to a device.
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4.4 Device Assignment

Note: In the Device Assighment dialog pane you first must assign the
EtherCAT Slave device to the EtherCAT Slave DTM by checking the
check box. This is essential to establish an online connection from the
EtherCAT Slave DTM to the EtherCAT Slave device later, as described in
section Connecting/Disconnecting Device on page 80.

Therefore in the Device Assignment dialog pane you scan for the
EtherCAT Slave device and select it.

If the device did not get a firmware or shall get a new firmware:

1. first you scan for the device (with or without firmware) and select the
device,

then you download a firmware to the device and

subsequently you scan for the device (with firmware) once more and
select the device again.

44.1 Scanning for Devices

1. Select Settings > Device Assignment in the navigation area.

2 The dialog pane Device Assignment is displayed.

Scan progress: 315 Devices (Current device: -)

EERENEEEENENEEENNNNENEENE
Device selection: suikable only -

| Device | Hardware Park IZI,I'1,|'2,|'3| Slok number | Serial nurnber | Driver | Channel Prokocal | Access path
O [Device Cf  -f-PROFIBUS/- 1 20148 CIFX Device Driver  Undefined Undefined LG AifE3_SYs

Access path: |

Figure 11:. Device Assignment - detected Devices (* The name of the device class is
displayed.) — Example for a device without firmware

2. Under Device Selection select suitable only.

3. Select Scan, to start the scanning process.

2 In the table all devices are displayed, which can be connected to the
EtherCAT Slave DTM via the preselected driver.

Note: For devices, which have been found via the cifX Device Driver in
the column Access path the indication ...\cifX[OtoN]_SYS is displayed.
This is correct, as long as a device did not get a firmware. After the
firmware download has been completed, in the column Access path the
indication ...\cifX[OtoN]_Ch[0to3] is displayed.
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Parameter

Meaning

Range of Value /
Default Value

Device selection

Selecting suitable only or all devices.

suitable only, all

Device

Device class of the EtherCAT Slave devices.

Hardware Port
0/1/2/3

Shows, which hardware is assigned to which communication interface.

Slot number

Shows the Slot Number (Card ID) preset at the PC card cifX via the Rotary
Switch Slot Number (Card ID).

The indication n/a means that no Slot-Nummer (Card ID) exists. This will
occur if the PC card cifX is not equipped with a Rotary Switch Slot Number
(Card ID) or for PC cards cifX equipped with a Rotary Switch Slot Number
(Card ID) if the rotary switch is set to the value 0 (zero).

1to9,
n/a

Serial number

Serial number of the device

Driver

Name of the driver

Channel Protocol

Shows, which firmware is loaded to which device channel.

The data for the used channel consists of the protocol class and the
communication class.

a.) For devices without firmware: Undefined Undefined,
b.) For devices with firmware: Protocol name corresponding to the used
Firmware

Access path
(last column on
the right)

Depending on the used driver in the column Access path different data to
the device are displayed.

For the cifX Device Driver the following data are displayed:
a.) For devices without firmware: ...\cifX[OtoN]_SYS,
b.) For devices with firmware: ...\cifX[0OtoN]_Ch[0to3].

cifX[OtoN] = Board number O to N
Ch[0to3] = Channel number 0 to 3

Depending on the
device and on the
driver:

board or channel
number, IP address
or COM interface

Access path

(at the lower side
of the dialog
pane)

If in the table a device is checked, under Access path (at the lower side of
the dialog pane) the driver identification or depending on the used driver
additional data to the device will be displayed.

For the cifX Device Driver the following data are displayed:
a.) For devices without firmware: ...\cifX[OtoN]_SYS,
b.) For devices with firmware: ...\cifX[0OtoN]_Ch[0to3].

cifX[OtoN] = Board number O to N
Ch[0to3] = Channel humber 0 to 3

driver identification
(ID)

depending on the
device and on the
driver:

board or channel
number, IP address
or COM interface

Table 16: Parameters of the Device Assignment
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4411 Scanning for all Devices or for suitable only

all
1. Under Device Selection select all.
2. Select Scan.

Scan progress: 515 Devices (Current device: -)

Scan

Device seleckion: Ell -
| Device | Hardware-Port 0f1/2)3 | Slat number | Serial number | Driver | Channel Prokocol | Access path
O Device ¥ -j-iPROFIBUS)- 1 " z0148 CIF¥ Device Driver  Undefined Undefined  ...\difx3_Svs
O [Device cf  -j-jDevicehst)- nia 20027 CIFY Device Driver  Undefined Undefined .. .\cifX1_S¥S
O bevice - nia 20053 nety Driver Undefined Undefined  ...}192.168.1.,
O [Device ©f  EthernetiEthernet--  nla 202585 CIFY Device Driver  Undefined Undefined .. \cif2_5YS
O Pevicecrl  -j-fCaMopen/- nia 20022 CIFY Device Driver Undefined Undefined . \ciFX0_Svs

Figure 12: Device Assignment - detected Devices (* The name of the device class is
displayed.) Example for Devices without Firmware

> In the table all devices are displayed, which are attainable in the
network and which can be connected to a single DTM each via the
preselected drivers.

Note: During a subsequent firmware download in the selection window
Select Firmware File all files from the selected folder are displayed,
under Files of Type ,All Files (*.*)* is displayed and the check box
Validate the selected firmware file. is unchecked.

suitable only
1. Under Device Selection select suitable only.

2. Select Scan.

2 In the table all devices are displayed, which can be connected to the
EtherCAT Slave DTM via the preselected drivers.

Note: During a subsequent firmware download in the selection window
Select Firmware File only firmware files from the selected folder are
displayed, under Files of Type ,Firmware Files (*.nxm)“ or ,Firmware
Files (*.nxf)* is displayed and the check box Validate the selected
firmware file. is checked.
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4.4.2 Selecting the Device (with or without firmware)

_) Note: A connection with the EtherCAT Slave DTM can only be
established with one EtherCAT Slave device.

To select the physical EtherCAT Slave device (with or without firmware):
1. Check the appropriate device.

Scan progress: 505 Devices (Current dewvice: -]

Device selection: suitable only -

| Device | Hardware Port IZI,|'1,|'2I3| Slok number | Serial number | Driver | Channel Protocal | Access path
[Device CrY  -f-IPROFIBLIS)- 1 20145 CIF¥ Device Driver  PROFIBUS Masker v fE3_SYS
|
Access path: | {368BECSE-0E92-4C0E-B4AD-64FE2AET AAF AP X3 _SYS

Figure 13: Device Assignment - Selecting the Device (* The name of the device class is
displayed.) — Example for a device without firmware / one Device is selected

2 Under Access path (below in the dialog pane) the access path to the
device, e. g. the driver identification, or depending on the used driver
additional access data of the device are displayed.

2. Select Apply, to apply the selection.

_) Note: Before an online connection from the EtherCAT Slave DTM to the
EtherCAT Slave device can be established, a firmware must be loaded to
the device and the device must be selected once more.

For further information refer to section to section Firmware Download on
page 51 or to section Selecting the Device once more (with Firmware) on
page 49.
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4.4.3 Selecting the Device once more (with Firmware)

Note: For repeated download this step is omitted.

To select the EtherCAT Slave device (with firmware and defined system
channel) once more, proceed as described hereafter:

L

PRSI

Under Device Selection select all.
Select Scan.

In the table all devices are displayed, which are attainable in the
network and which can be connected to a DTM via the preselected
drivers.

Check the appropriate device.

Scan progress: 5/5 Devices (Current device: -)

Scan

Device selection: I -

| Device | Hardware-Part 0f1/2/3 | Slot number | Serial number Driver | Channe| Protocol | Access path

[l Device cf]  -j-[PROFIEUS/- 1 20148 CIFY Device Driver  PROFIBUS-DP Master  ...\cif3_cChO
O --|Devicelet)- nia 20027 CIFY Device Driver  DeviceMst Master L af¥1_cho
O -1--- nia 20056 nety Driver Undefined Undefined ...\ 192,168, ...
O Ethernet/Ethernet(--  nfa 20285 CIFY Device Driver  PROFINET IO Device ... \cifs2_cho
O Device o  -j-Calopen)- nfa 20022 CIF% Device Driver Undefined Undefined . \cifs0_SYS

|

Access path: | {368BECSB-0E92-4C0E-B4A9-64F62AE7AAFA 3 _ChD

Figure 14: Device Assignment - Selecting the Device (* The name of the device class is
displayed.) — Example for Devices with and without Firmware / one Device is selected

Note: After the firmware download has been completed, for the devices which have been
detected via the cifX Device Driver the following data are displayed:

In the column Channel Protocol: the data for the firmware for the used channel

In the column Access path or under Access path (below in the dialog pane):
the data: ...\cifX[0OtoN]_Ch[0to3].

cifX[OtoN] = board number O to N
Ch[0to3] = channel number 0 to 3

Select Apply, to apply the selection.

Or select OK, to apply the selection and to close the DTM interface
dialog.

Connect the DTM to the device using the context menu (right mouse
click).
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Or:

suitable only
1. Under Device Selection select suitable only.

2. Select Scan.

2 In the table all devices are displayed, which can be connected to the
EtherCAT Slave DTM via the preselected drivers.

3. Check the appropriate device.

Scan progress: 55 Devices (Current device: -)

Device selection: suitable anly -

| Device | Hardware Part EI,I'I,I'Z,I'3| Slot number | Serial number | Driver Channel Prokacal | Access path
Device Cr  -/-PROFIBUS/- 1 Z014a CIF¥ Device Driver  PROFIBUS-DP Master L AcifRE_Cho
|
Access path: | {368BECSE-0E92-4C0E-B4A0-E4FE2AE7AAFAMCIFL3_Cha

Figure 15: Device Assignment - Selecting the Device (* The name of the device class is
displayed.) — Example for a device with firmware / one Device is selected

detected via the cifX Device Driver the following data are displayed:

.i Note: After the firmware download has been completed, for the devices which have been
- Inthe column Channel Protocol: the data for the firmware for the used channel

- Inthe column Access path or under Access path (below in the dialog pane):
the data: ...\cifX[OtoN]_Ch[0to3].

cifX[OtoN] = board number O to N
Ch[0to3] = channel number 0 to 3

Select Apply, to apply the selection.

Or select OK, to apply the selection and to close the DTM interface
dialog.

6. Connect the DTM to the device using the context menu (right mouse
click).

For further information how to establish an online connection from the
EtherCAT Slave DTM to the EtherCAT Slave device, refer to section
Connecting/Disconnecting Device on page 80.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
DOC1107020I04EN | Revision 4 | English | 2017-03 | Released | Public © Hilscher, 2012-2017



Settings 51/125

45 Firmware Download

Using the Firmware Download dialog a firmware can be transferred to the
device.

_) Note: Prior to the firmware download, you must select the driver and the
Slave device (with or without firmware) and the device must be assigned
to the hardware.

For further information refer to section Overview Settings on page 32.

To load the firmware to the device:
1. Inthe navigation area select Settings > Firmware Download.

2 The dialog Firmware-Download pane is displayed.

Mame: r Erowse, ..

Version:

& CALTION:

The Firmware download

- stops the bus communication,

- erases the configuration database and

- overwrites the existing Firmware in the device,

To complete the update and to make the device operable again, please re-download the
configuration when this operation has finished.

[ inisd

Figure 16: Firmware Download

Element Meaning

Name The path and name of the firmware file selected are displayed.

Version The version and build version of the firmware file selected are displayed.
Browse... Via ‘Browse..." you can select the firmware file for the download.
Download Via ‘Download’ you can download the firmware to the device.

Table 17: Parameter Firmware Download
» Select Browse.

Device is not assigned to the Hardware

If the device is not assigned to the Hardware, the error message ‘The
device is not assigned to the hardware?!’ is displayed:
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Figure 17: Error Message ‘The device is not assigned to the hardware!’

» Click OK and select and assign the Master device as described in
section Device Assignment.

Device is assigned to the Hardware

2 The selection window Select Firmware File is displayed.

» Enlarge the selection window to view the columns Hardware and
Version.
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Lok in: | J. CIFX ~|
= Mame : Firmware Hardware WVersion I
el | ECM
|| Recent Places DECS V4K
| J EIM_mit_QC
- ) PNIM
Desktop | PNSV3.5.X
= ) 53M
= OE cifx2asm.nf AS-Interface Master CIFX [x.x (Build x)]
Libraries ot cifx2dprm.nxf PROFIEUS-DP Master CIFX [x.x (Build x)]
3 cifx2dps.nxf PROFIBUS-DP Slave CIFX [ x (Build x)]
[}E. 0k cifxccs.nf CC-Link Slave CIFX [x.x (Build x)]
Computer Mt cifecom.nxf CAMopen Master CIFX [ (Build x)]
- 3 cifxcosnuf CAMopen Slave CIFX [x.x (Build x)J
Qg ¢k cifxdnm.nxf DeviceMet Master CIFX [x.x (Build x)]
Network ¢k cifudns.nxf DeviceMet Slave CIFX [x.x (Build x)]
o cifxdprm.nxf PROFIBUS-DP Master CIFX [ x (Build x)]
O cifdps.naf PROFIBUS-DP Slave CIFX [ x (Build x)]
Ok cifxecrn.nxf EtherCAT Master CIFX [ (Build x)]
0k cifxecs.nxf EtherCAT Slave CIFX [x.x (Build x)J
O cifieim. naf EtherMet/IP Scanner CIFX [ x (Build x)J
Ok cifxeis.nuxf EtherMet/IP Adapter CIFX [x.x (Build x)]
Mcif’xmpi.nxf PROFIBUS-MPI Messaging CIFX [x.x (Build x)f
ok cifxornb.nf Open Modbus/TCP Messaging CIFX Ly (Build x)]
13 cifxpls.nuxf POWERLIME Controlled MNode CIFX [x.x (Build x)J
i3 cif {pnm.nxf PROFIMNET-IC IO Controller CIFX [x.x (Build x)J
ok cifxpns, nuf PROFIMET-I0 10 Device CIFX [ x (Build x)]
0 cifesIm.nuf SERCOS I Master CIFx [ x (Build x)]
ek cifes3s.nd SERCOS I Slave CIFX [ x (Build x)]
0L cifiovrs.nuf YVARAM Slave CIFX [ (Build x)]
File name: |ﬂ'u'ame of the Firmware Filel nxf or nxm j Open I
Files of type: |F|n1'|ware Files {*.rof ;™ room) ﬂ Cancel |
Recent folders: | [Path of the last used Folder] | Help |
Firmware: [Firmware Mame, Version, Device Class]
Figure 18: Window ‘Select Firmware File’ (Example CIFX)
Parameter Meaning Range of Value /
Default Value
Column Name | File name of the firmware file nxf, nxm
To sort the entries of the window Select Firmware File by name click to
the column head MNeme
Column Name of the firmware (consisting of the protocol name and protocol class)
Firmware
Column Device class of the associated hardware e. g. CIFX,
Hardware COMX, COMX 51,
NETJACK 10,
NETJACK 50,
NETJACK 51,
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NETJACK 100,
NETTAP 50 (Gateway),
NETTAP 100 (Gateway),
NETBRICK 100 (Gateway)
Column Firmware version x.X (build x)
Version
Tooltip To view the tooltip information move with the mouse pointer over the
selected firmware line.
Type: Hilscher firmware file for neti-based targets (NXF)
Size: 563 KB
Date of change: 2013/03/26 11:10
Files of Type |,All Files (*.*)" if before in the Device Assignment pane under Device All Files (*.%),
selection all was selected. Firmware Files (*.nxm),

, Firmware Files (*.nxm)* or Firmware Files (*.nxf) if before in the Device | Firmware Files (*.nxf)

Assignment pane under Device selection suitable only was selected.

Recent folders

Path of the recently opened folder

Firmware As soon as the firmware file has been selected, under Firmware the Name, Version, Build
name, the version and the build version as well as the device class for the | Version, Device Class
selected firmware is displayed. for the selected firmware

Help Button, to open the online help of the DTM.

Table 18: Parameters Select Firmware File

,  Further descriptions to the selection window Select Firmware File are
| included in the context sensitive help (F1 key) of the Microsoft
»  Corporation.

has been set, during a subsequent firmware download in the selection window Select

.3 Note: After in the Device Assignment pane under Device selection all or suitable only
Firmware File the following data are displayed or set:

(for list box entry —) all suitable only
In the selection window all files from the only firmware files from the
Select Firmware File: selected folder selected folder
Under Files of Type*: LAl Files (*.%)" LFirmware Files (*.nxm),
JJFirmware Files (*.nxf)*
Validation: A restricted validation | A validation is made whether
will be performed if the firmware file is suitable for

the selected firmware | the EtherCAT Master DTM.
is applied for the
download.

*These settings in the selection window Select Firmware File can also be changed
manually.

3. In the selection window mark the firmware file to be loaded using the
mouse.

2 In the selection window under Firmware the name and the version of
the firmware are displayed.

4. In the selection window select the Open button.

Validation

2 A validation is made, whether the selected firmware file is suitable for
the EtherCAT Master device.
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Invalid Firmware

NOTICE

Device Destruction caused by invalid Firmware

Loading invalid firmware files could render your device unusable.

2 If a firmware file is selected, which is not valid for the assigned device,
the request Select Firmware File will be displayed.

‘Invalid firmware for assigned device!
[detailed explication]

Shall firmware file nevertheless be applied for the download?’

Select Firmware File [%|

'T Ireealid Firmware for the assigned device!
L

The hardware options do nat makch,
Reqguired: -/-/CaANopen/-
Firrmmare file: -f-/PROFIBUS)-

The prokocol classes do nok match,
Required: CAMopen
Firrmware file: PROFIBUS-DP

Shall the Firmware file nevertheless be applied
for the download?

Yes

Figure 19: Request Select Firmware File - Example Invalid Firmware

» Answer to the request with No and select a valid firmware.

R The selection window is closed.

Valid Firmware

2 The selection window is directly closed (without dialog).

5. Start firmware upgrade.

| & WARNING|

Personnel Injury in Consequence of a Communication Stop

= Stop your application program before starting upgrading the firmware.

= Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before upgrading the firmware.

= Unexpected equipment operation may cause personal injury.
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NOTICE

Damage of Equipment and Loss of Device Parameters in
Consequence of a Communication Stop

= Stop your application program before starting upgrading the firmware.

= Make sure that your equipment operates under conditions that prevent
property damage. All network devices should be placed in a fail-safe
mode before upgrading the firmware.

= Unexpected equipment operation may cause property damage.

= Before you initiate firmware download make sure that your project
configuration data are saved non-volatile in order to prevent loss of
configuration data.

Invalid or non-authorized Firmware

= Loading invalid or non authorized firmware files could render your
module unusable. Only proceed with a authorized firmware update.

» In the dialog pane Firmware Download click to the Download button,
to download the firmware.

 The request Do you really want to download the firmware? is

displayed.
\‘ii/ Do wiou really wank to download the new Firmware?

ves |

Figure 20: Request - Do you really want to download the firmware?

Click Yes.

If you are sure, that you have selected the appropriate firmware file
answer to the request with Yes otherwise with No.

v @

2 During the download a progress bar is displayed (‘Download active,
device performs initialization...”), in the status line a clock / green hook
symbol is displayed and in the dialog pane Firmware Download
Download is grayed out.

netDevice

Device: Device Name [Description] =Station Addresss (Network 10)
Downlaad active, device perfarms inikialisation. ..

29 % complete

Figure 21: Firmware Download - Progress Bar

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
DOC1107020I04EN | Revision 4 | English | 2017-03 | Released | Public © Hilscher, 2012-2017



Settings 57/125

=05 () (T} Firmware Dawrload

=0 | i

Figure 22: Clock Symbol and Hook Symbol green

2 In the Firmware-Download dialog pane the path and name as well as
the version of the selected firmware file are displayed.

Mame: IName of the Firmware File]

Version: Iiersion and Boild Wersion of the Firmware]

& CAUTION:
The firmware download

- skops the bus communication,
- erases the configuration database and
- overwrites the existing firmware in the device.

Tao camplete the update and ko make the device operable again, please re-dawnload the

configuration when this operation has finished,
Download

Figure 23: Firmware Download — Download
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5 Configuration

5.1 Overview Configuration

511 General Remarks

The appearance of the EtherCAT Slave DTM depends on the mode of
invocation, i.e. whether the EtherCAT Slave DTM has been dragged to the
root line (Stand-alone Slave) or to a Master line (Slave connected to a
Master).

Take care of the descriptions in the section Configuration Steps on page
24,

Note: In order to transfer the configuration to the EtherCAT Slave device,
download the data of the configuration parameters in the EtherCAT Slave
device. See section Download Configuration on page 82.

51.2 Slave DTM at the Root-Line (Stand-Alone Slave)

In this case of the tree view looks like:

M awigation Area =
a Settings
a Driver
TCP/IP Driver for neti
netx Driver

Device Assignment
Firrmware Download
£ Configuration
iy General Setkings

'a Description
“ML DDF Viewer

Figure 24: Configuration (Slave DTM at the Root-Line (Stand-Alone Slave))

If the EtherCAT Slave DTM is dragged to the root busline within the
network project, at Configuration the following panes will be available:

Configuration > General Settings

Dialog Panes “Configuration”

The table below gives an overview about the available Configuration
dialog panes descriptions:

Folder Name / Subsection Page
Section
Configuration General Settings 63

Table 19: Dialog Panes Configuration

All other descriptions given in this chapter are not applicable if the
EtherCAT Slave DTM has been dragged to the root busline in the network
project.
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5.1.3 Slave DTM at the Master Busline

In this case of the tree view looks like:

M avigation Area =
a Setkings
a Drriver
TCPRJIP Driver For nekx
netx Driver

Dervice Assignment
Firrmware Download

Configuration

ey GEneral
General Settings
Behawvior

=3 MailBiox

CoE

a Description
“ML DOF Viewer

Figure 25: Configuration > General (Slave DTM at the Master busline)

If the EtherCAT Slave DTM is dragged to the Master busline of the
EtherCAT Master DTM within the network project, at Configuration the

following panes will be available:
e General pane
e General Settings pane
e Behavior pane

e Mailbox pane

Dialog Panes “Configuration”

The table below gives an overview about the available Configuration

dialog panes descriptions:

Folder Name / Subsection Page

Section

Configuration General 62
General Settings 63
Behavior 69
Mailbox 76

Table 20: Dialog Panes Configuration
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5.2 Configuring Slave Parameters

The steps provided in the following two sections are alternatively required
for the two cases listed hereafter, to configure the parameters of the
EtherCAT Slave device using the EtherCAT Slave DTM:

e Slave DTM at the Root-Line (Stand-Alone Slave)

e and Slave DTM at the Master busline.

5.2.1 Slave DTM at the Root-Line (Stand-Alone Slave)

If in the network project the EtherCAT Slave DTM is dropped to the root
busline:

General Settings

1. Set the Device Settings:
» Select Configuration > General Settings in the navigation area.

» Under Bus Startup: Select option Automatic or Application
Controlled.

» Under Watchdog time: Set Watchdog time.

Close Slave DTM Configuration Dialog

2. Click OK in order to close the Slave DTM configuration dialog and to
store your configuration.

Configuration Download to the EtherCAT Slave Device

Adhere to the necessary safety precautions to prevent personnel injury and
property damage that may occur in consequence of a communication stop
or in consequence of a mismatching system configuration.

Note: In order to transfer the configuration to the EtherCAT Slave device,
download the data of the configuration parameters in the EtherCAT Slave
device. See section Download Configuration on page 82.

Further Information

. For more information refer to the section hereafter.
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5.2.2 Slave DTM at the Master Busline

If in the network project the EtherCAT Slave DTM is dropped to the root
busline:

General
1. Putin an optional description of the device

» Select Configuration > General. If you want, you can put in a
descriptive text about the slave device under Description.

General Settings

2. Set the Device Settings:
» Select Configuration > General Settings in the navigation area.

» Under Bus Startup: Select option Automatic or Application
Controlled.

» Under Watchdog time: Set Watchdog time.

Behavior
3. Make the settings concerning the behavior of the device:

» In the navigation area, select Configuration > Behavior and then
make your settings.

Mailbox >CoE

4. Make settings for CoE (CANopen over EtherCAT):

» In the navigation area, select Configuration > Mailbox >CoE and then
make your CoE settings.

Close Slave DTM Configuration Dialog

3. Click OK in order to close the Slave DTM configuration dialog and to
store your configuration.

Configuration Download to the EtherCAT Slave Device

Adhere to the necessary safety precautions to prevent personnel injury and
property damage that may occur in consequence of a communication stop
or in consequence of a mismatching system configuration.

Note: In order to transfer the configuration to the EtherCAT Slave device,
download the data of the configuration parameters in the EtherCAT Slave
device. See section Download Configuration on page 82.

Further Information

, For more information refer to section General on page 62, to section
) General Settings on page 63, to section Behavior on page 69 and to
¥ section Mailbox on page 76 of this document.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
DOC1107020I04EN | Revision 4 | English | 2017-03 | Released | Public © Hilscher, 2012-2017



Configuration

62/125

5.3 General

Descripkion:
Device bvpe:
Device name:
Product revision:
Phrysics:

Station Address:

The General pane shows the Description of the EtherCAT Slave.

This pane is only available in case of a Slave DTM at the Master busline.

Note: The Station Address is set by the EtherCAT Master, therefore the

corresponding data field is not editable.

| CIF% REJECS ¥0.2

Mote: Station Addresses are logical ones and are set in Master DTM Far all slaves.,
Figure 26: Configuration > General

Parameter Meaning Editable
Description Symbolic Name of the EtherCAT Slave station Yes
Device type Device type as defined in the DDF No
Device name | Device name as defined in the DDF No
Product Product revision as defined in the DDF or E2PROM No
revision
Physics EtherCAT Port configuration: available ports and their types, see Table 22: No

Coding of Parameter "Physics" below.
Station Station Address denominates a logical address. No
Address The station address of a slave is set in the Master DTM.

Table 21: General Page Parameters

Physics in the context of EtherCAT Port configuration is described by two
characters indicating the physical interface of the connection. The coding is

as follows:
Physics Port type
K E-Bus
Y 100Base-TX
F 100Base-FX

Table 22: Coding of Parameter "Physics"
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5.4 General Settings

At the General Settings pane device related settings can be made. These
settings are assigned with the download of the configuration.

Information about the download you find in section Download
Configuration on page 82.

Interface

Bus Startup: |.ﬁ.ut|:|matin: j

Watchdag Time: | 1000 ms

1 Data Status: | =]

[dent

Vendar ID: | [~ Enable

Product Code: |

Revision Murmbet: |

Serial Mumber: |

Data

Inpuk Data Bvtes: | 200

Outpdt Data Bytes: | 200

SyncImpulseLength: | 100 x=10ns
ITI Cancel Apply

Figure 27: General Settings

_) Note: The setting options at the dialog pane General Settings for client
specific variants of the configuration software can differ from the setting
options displayed here.
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54.1 Interface Parameters

5411 Bus Startup
This parameter offers the options Automatic an Application Controlled.

If Automatic is selected, the EtherCAT Master device starts with the data
exchange on the bus after the initializing has been ended.

When Application Controlled is selected, the application program must
activate the data exchange on the bus.

_) Note: The setting options under Bus Startup for client specific variants of
the configuration software can differ from the setting options displayed
here.

5.4.1.2 Watchdog Time for Application Monitoring

Watchdog time: 1000 ms

Figure 28: Device Settings > Application Monitoring

The Watchdog time determines the time within which the device watchdog
must be re-triggered from the application program while the application
program monitoring is activated. When the watchdog time value is equal to
0 the watchdog is deactivated and the application program monitoring is
deactivated too.

The permissible range of values of the watchdog time is 20 to 65535. By
default the watchdog time value equals to 1000 ms.

Watchdog time Range of Value / Value
Permissible range of values 20 ... 65535 ms

Default 1000 ms

The software watchdog is deactivated. 0 (ms)

Table 23: Range of Value / Value for the Watchdog time

_) Note: The setting options under Watchdog Time for client specific
variants of the configuration software can differ from the setting options
displayed here.

54.1.3 I/0 Data Status

This parameter allows setting of the status of the input or the output data
i.e. the 1/O Status Enable bit (bit 1 of the system flags) and the 1/O Status
8/32Bit bit (bits 2 of the system flags).

For each input and output date the following status information (in Byte) is
memorized in the dual-port memory.

Currently the field is grayed out as only the option ‘None’ is supported.
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54.2 Ident Parameters
The following table lists all ident parameters of the EtherCAT Stand-alone
Slave DTM along with their meaning and their default values:
Parameter Meaning Default value Subindex (within
Object 0x1018)
VendorID Vendor Identification 0xE0000044 1
number of the (denoting device
manufacturer of an has been
EtherCAT device. manufactured by
Hilscher)
Product code Product code of the 1 2
device
Revision Revision number of the | 0x20001 3
device as specified by
the manufacturer
Serial number Serial number of the 0 4
device
Table 24: Ident Parameters
These parameters are exactly those which are also stored in EtherCATs
object dictionary within the object with index 0x1018 thus the table also
mentions the corresponding subindex numbers of each parameter.
The values for the parameters VendorID, Product code and Revision can
be taken from the XML file which is bundled with the particular firmware.
The following default value sets for the identification data have been
defined:
Firmware Vendor Id Product Code Revision Number
cifX 0xE0000044 0x00000001 0x00020001
comX 0xE0000044 0x00000003 0x00020001
netiC 0OxE0000044 0x0000000B 0x00000000
Table 25: Values for the Ident Parameters Vendorld, ProductCode and RevisionNumber
5.4.3 Data Parameters
The following table shows the data parameters of the general Settings.
Parameter Meaning Default value Maximum value
Input Data Process Data Input Size 200 Byte 256 Byte
Bytes Number of data bytes used
for input
Output Data Process Data Output Size 200 Byte 256 Byte
Bytes Number of data bytes used
for output
Sync impulse Sync impulse length (in units | 100 65535
length of 10 ns) (= 1000 ns) (2655350 ns)

Table 26: Data Parameters
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5.44 Messages

544.1 Errors

The following table provides an overview which error situations might occur
in the “General Settings” pane.

Problem The error message
Error E|

@ Parameter validation error! Watchdog time field accepted values are 0, from 20 to 65535,

appears.

Explanation | This error message appears in case either a value below 20 but unequal 0 or a
value exceeding 65535 is put in for the watchdog time in the configuration pane.

Action Put in a correct the value for the watchdog time (between 20 and 65535) or switch
the watchdog feature off (in order to do so, set the value of the watchdog time
equal to 0)!

Problem The error message

Error, PE|

@ Watchdogtime may nok be emply!

appears.

Explanation | No value at all has been put in for the watchdog time in the configuration pane.

Action Put in a correct the value for the watchdog time (between 20 and 65535) or switch
the watchdog feature off (in order to do so, set the value of the watchdog time
equal to 0)!

Problem The error message

Error E|

@ Yalue is not walid!Walid range is 0-256.,

appears.

Explanation | The specified value for the length of either input or output data exceeds the upper
limit of 256 bytes.

Action Specify a lower value either for the input data length or for the output data length!

Problem The error message
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Error E'

@ Parameter validation error! Tokal sum of input and output bytes may not be 0,

appears.

Explanation

The specified values of input data length and output data length may not be 0 at
the same time.

Action Specify at least one non-zero value either for input data length or output data
length.

Problem The error message

Error E'
@ Parameter validation error! Takal sum of inpuk and outpuk bytes may not exceed 512 bytes,
appears.

Explanation | The sum of the specified values of input data length and output data length may
exceed 512 bytes.

Action Specify a lower value for at least one of these values so that the sum of both
values does not exceed the 512 bytes limit.

Problem The error message

Input walidation error! Input field accepts only digits and letters From & ko F.
appears.

Explanation | In an input field requiring a hexadecimal value, you tried to put in a character
which is neither a digit nor any of the letters (“A,B,C,D.E,F"), for instance another
letter.

Action Correct your input accordingly!

Problem The error message

Parameter validation error! Input field may nok be empky.,
appears.
Explanation | An input field (either the input data length or the output data length) is empty.
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Action Check for the empty field. Then specify a valid value there.
Problem The error message
Error E|
@ Yalue is not valid!valid range is 0-65535,
appears.
Explanation | The specified value for the Sync Impulse Length exceeds the upper limit of 65535
bytes.
Action Specify a lower value either for the Sync Impulse Length!
Table 27: Possible Error Messages issued at General Settings Pane
5.4.4.2 Warnings
The following table provides informs about which warnings might appear in
the configuration pane.
Problem The error message
Warning Pg|
Configuration data has been changed.
\__4- Do wou wank to save the data?
.............. Ja Mein Abbrechen
appears.
Explanation | You have changed the configuration data.
Action If you want to store the configuration data permanently, click at Yes otherwise at
No or return to preceding screen with Cancel.

Table 28: Possible Warning Messages issued at General Settings Pane
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5.5 Behavior

At the page Behavior, the parameters of

¢ the state machine timeout values
¢ the device checkup,

e the process data

e and the watchdog timer.

are set and displayed.

This pane is only available in case of a Slave DTM at the Master busline.

"2 netDevice - Configuration CIFX RE/ECS VO.2[CIFX RE/ECS V0.2]<256> M=1E3
‘i [ODevice:  CIFRREJECS Device It 000000001 L
— Wendor: Hilscher GrbH Wendor ID: DxED000044 DT

Navigation Area B
= Séatt;?jer State Machine Timeout [mz)

TCPJIP Driver For nets I2P: 3000
ret Driver P25, 520 ’710000

Device Assignment

Firrnwware Download Backto R, It S000

¥-3 Configuration 0125 200
General
General Settings Device checkup
Iv vendorlD
24 MailBox Eneer
CoE Iv Product cade

=3 Description [~ Revision
ML DDF Yiewer

Process data

v Use LRDJL'WR instead of LRW

‘wiatchdog
™ Set mulkiplier (Req. 400 h):
[~ Set PDI watchdog (Reg. 410 hi: o0 me | 100,000
[ Set 5M watchdog (Req. 420 h: (1000 ms 100,000

QF, | Cancel Apply

=Il= Disconnected [] Data Set f

Figure 29: Configuration > Behavior
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55.1 State Machine Timeout

For various transitions between states of the EtherCAT slave state machine
the associated timeout values can be configured separately in the state
machine timeout section of the ‘Behavior’ dialog:

o 2P
This value applies to the transition from Init state to Pre-Operational
state

e P2S,S20

This value applies to the transition from Pre-Operational state to
Safe-Operational state and from Safe-Operational state to
Operational state.

e BacktoP, I

This value applies to the transition from any higher state back to Pre-
Operational state or Init state.

o 025

This value applies to the transition from Operational state to Safe-
Operational state.

Note: These timeout values are specified in units of milliseconds.

State Machine Timeout [ms)

I=P: 3000
P25, 520 10000
Back to P, I: S000

025 200

Figure 30: Configuration > Behavior > State Machine Timeout - Configuration
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55.2 Device Check-up

Device checkup
v YendorID
[v Product code

[ Revision

The device check-up part of the Behavior dialog looks like:

Figure 31: Configuration > Behavior > Device Check

The following table shows which items identifying the EtherCAT device can
optionally be verified during device check-up if marked in the dialog
accordingly.

Parameter Meaning

VendorID Device’s vendor ID (DDF or stored device-internally)
Product code Device’s product code (DDF or stored device-internally)
Revision Device's revision (DDF or stored device-internally)

Table 29: Parameters Behavior > Device checkup

A verification of the serial number is not available here.

The values within the DDF file are verified against the corresponding
information stored in the device (for example, within an E2PROM circuit), if
the according check box is marked.

55.3 Process Data

Process data

EtherCAT supplies different command sets for reading and writing:
e a combined read/write command (LRW)

e separate read and write commands (LRD/LWR)

This option allows to choose between these alternatives:

[v Lse LRDYL'WR instead of LR

Figure 32: Configuration > Behavior > Process data

Parameter Meaning

Use LRD/LWR Logical read and write operation:

instead of LRW If marked, separate EtherCAT read (LRD) and write
(LWR) commands will be used.

Otherwise, a combined EtherCAT read and write
(LRW) command will be used.

Table 30: Parameters Behavior > Process data

For more information on EtherCAT read and write commands see the
EtherCAT Communication Specification, version 1.0, section 6.2 “EtherCAT
Services”, page 43.
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554  Watchdog

Both the entire PDI (Process Data Interface) and all sync managers
(separately) are monitored by watchdog timers.

The following rules apply for resetting the watchdog timers:

e Each access from the application controller to the EtherCAT Slave
controller resets the watchdog timer of the Process Data Interface.

e Each write access to the associated memory area of a sync manager
resets the sync manager’s watchdog timer.

The watchdog timeout values can be calculated using the formula given
below from an individually configurable value and a common multiplier.

The “Watchdog” part of the “Behavior” dialog allows specifying the
multiplier and the individual values for PDI watchdog and sync manager
watchdogs.

Wwatchdog
[ Set mulkiplier (Reqg. 400 R
[ Set POI watchdog (Reqg. 410 hi: o0 me 100,000
[ 5k 5Mwatchdog (Reg. 420 hi: [ioo0 s [100.000

Figure 33: Configuration > Behavior > Watchdog

Parameter Meaning

Set multiplier Watchdog multiplier, content of the register 0x400

Set PDI watchdog | PDI watchdog, see note below

Set SM watchdog | SM watchdog, see note below

Include WC state If this check box is marked, an input variable is added to the slave
Bit(s) device, that shows the working counter state of the EtherCAT slave
device.

Table 31: Parameters Configuration > Behavior > Watchdog

Note: The PDI & SM watchdog timeout values are calculated as follows.
PDI watchdog timeout =

([value of register 0x400] + 2) * 40 * [value of register Ox 410]

SM watchdog timeout =

([value of register Ox 400] + 2) * 40 * [value of register 0x 420]
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5.5.5 Messages

555.1 Errors

The following table provides an overview which error situations might occur
in the “Behavior” pane.

Problem The error message

@ Invalid State Machine Timeout{I-=F)! The valid range is O - 65535,

appears.

Explanation | The specified value for the State Machine Timeout (I->P) exceeds the upper limit
of 65535 bytes.

Action Specify a lower value than 65535 for the State Machine Timeout (I->P)!

Problem The error message

Error f'5_<|

@ Ireealid State Machine Timeouk(P- =3, 5-=0) The walid range is 0 - 5535,

appears.

Explanation | The specified value for the State Machine Timeout (P->S,S->0) exceeds the
upper limit of 65535 bytes.

Action Specify a lower value than 65535 for the State Machine Timeout (P->S,S->0)!

Problem The error message

Error r5_<|

@ Invalid State Machine Timeout{Back to P,I! The valid range is 0 - 65535,

appears.

Explanation | The specified value for the State Machine Timeout (Back to P,l) exceeds the
upper limit of 65535 bytes.

Action Specify a lower value than 65535 for the State Machine Timeout (Back to P,I)!

Problem The error message
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Error [‘S__<|

@ Irrealid State Machine Timeouk(2-=33! The valid range is 0 - A5535,

appears.
Explanation | The specified value for the State Machine Timeout (O->S) exceeds the upper limit
of 65535 bytes.
Action Specify a lower value than 65535 for the State Machine Timeout (O->S)!
Problem The error message
Error [‘S__<|
@ Invalid multiplier {Reg. 400 R The valid range is 0 - 65535,
appears.
Explanation | The specified value for the Multiplier (Register 0x400) exceeds the upper limit of
65535 bytes.
Action Specify a lower value than 65535 for the Multiplier (Register 0x400)!
Problem The error message
Error rz|
@ Irwalid PDI watchdog (Req. 410 k) The walid range is 0 - 65535,
appears.
Explanation | The specified value for the PDI Watchdog (Register 0x410) exceeds the upper
limit of 65535 bytes.
Action Specify a lower value than 65535 for the PDI Watchdog (Register 0x410)!
Problem The error message
@ Irealid SM watchdog (Reg. 420 b)Y The valid range is O - 65535,
appears.
Explanation | The specified value for the SM Watchdog (Register 0x420) exceeds the upper

limit of 65535 bytes.
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Action Specify a lower value than 65535 for the SM Watchdog (Register 0x420)!

Table 32: Possible Error Messages issued at Behavior Pane

5.5.5.2 Warnings

The following table provides informs about which warnings might appear in
the configuration pane.

Problem The error message

Warning g|

9P Configuration data has been changed.
\__-(/ Do ol wank to save the datar

= abbrechen

appears.

Explanation | You have changed the configuration data.

Action If you want to store the configuration data permanently, click at Yes otherwise at
No or return to preceding screen with Cancel.

Table 33: Possible Warning Messages issued at Behavior Pane
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5.6 Mailbox

This pane is only available in case of a Slave DTM at the Master busline. It
has one option: CoE.

5.6.1 CoE

For slave devices supporting the CoE MailBox, the following dialog page is
additionally displayed:

b ailBox Synchdanager
MbexCuk SM-Channel: 0 Mbe Ok size: 128

MbxIn SM-Channel: 1 MbxIn size: 128

Mote: CoE Configuration is done in Masker DTMI

Figure 34: Configuration > Mailbox > CoE Mailbox Settings

The dialog page provides the following information:
e The channel number of the sync manager (for mailbox input and output)

¢ The configured mailbox size (this applies both for the input mailbox and
for the output)mailbox

The complete MailBox configuration for each slave with MailBox support is
done in the EtherCAT Master-DTM.
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6 Description

6.1 Overview Description

The Description pages contain the following information:

e XML Viewer page: the devices XML file content in HTML style.

Description Dialog Panes

The table below informs about the contents of the Description dialog page:

EtherCAT Slave-DTM

Device Assignment
Firrmware Download
=3 Configuration
Gaeneral Settings
a Description
e WML DDF Viewer

Navigation Area — Description

Folder Name / Section Page
XML DDF Viewer 77
M avigation Area =
a Setkings
a Driver
TCPYIP Driver For nety
nety Driver

Table 34: Descriptions of the Description Pages
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6.2 XML DDF Viewer

The XML DDF Viewer displays the content of the DDF file of the device
which is stored in an XML format..

File narne: |Here the path to the XML DOF file of the device is displayed.

Find what: I Find Me:xt | [ Match case

[ Match whole word

<7aml version="1.0" 7= :I
- <EtherCATInfo =mins: zsi="http:f /www . w3.0rg/ 2001 /XMLSchema-
instance" xsi:noMamespaceSchemalocation="EtherCATInfo.xsd"
Yersion="1.2"=
- =Nendors=
<Id=2/Td=
<M amezBeckhoff Automation GmbH</MHamez

<Imagelataltx14-=424DE60000000000000076000000280000001000001
< endors
- =Descriptions=
— <Eroups:
- <Group SortOrder="520"=
< Type=Drive</Type>
<Mame Lcld="1033"=Drives</MNamex
<Imageloxl14=DRIVE</Imageloxl4>
< /Groupz

P e R Ll hal
*II I 3

Figure 35: XML DDF Viewer

Under Filename the absolute file directory path and the file name of the
displayed DDF file is displayed. Find what offers a search feature to search
for text contents within the text of the DDF file.

In the DDF Viewer window on the left side, the line number is displayed for
simple overview, the further entries show the DDF file in text format.

Parameter Meaning

Fllename File directory path and the file name of the displayed DDF file.

Find what Search feature to search for text contents within the text of the
DDF file.

Match case Search option

Match whole word Search option

Table 35: Device Description — XML DDF Viewerr
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The XML DDF Viewer page consists of the following elements:
¢ File name shows the absolute path of the DDF file.
e Find what offers searching for specific text within the DDF file.

e Using the Find Next button allows you to jump to the next occurrence of
the text to be searched for within the XML DDF file.

e Check Match case if you want to perform a case-sensitive search.

e Check Match whole word if only entire words should match and
fragments of words should be excluded from matching.

_) Note: You can also access the search functionality of the XML DDF
Viewer by typing Ctrl-F on the keyboard.
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7 Online Functions

7.1 Connecting/Disconnecting Device

Note: Several EtherCAT Slave DTM functions e. g. Diagnosis or the
configuration download in the FDT Framework require an online
connection from the EtherCAT Slave DTM to the EtherCAT Slave device.

Connecting Device

The following steps are needed to establish a connection from the
EtherCAT Slave DTM to a EtherCAT Slave device:

Under Settings in the Driver pane:

1. Verify that the default driver is checked and respectively check another
or multiple drivers.

2. Configure the driver if necessary.
Under Settings in the Device Assignment pane:
3. Scan for the devices (with or without firmware).

4. Select the device (with or without firmware) and apply the selection.

\  Before you download the firmware adhere to the necessary safety
) precautions to prevent personnel injury and property damage that may

occur in consequence of a communication stop. For more refer to section
Safety Messages on Firmware or Configuration Download on page 30.

Under Settings in the Firmware Download pane if not yet a firmware was
loaded to the device:

5. Select and download the firmware.

Under Settings in the Device Assignment pane if not yet a firmware was
loaded to the device:

6. Scan for the device (with firmware) once more.

7. Select the device (with firmware) once more.

An overview of the descriptions for these steps you find in the section
Overview Settings on page 32.

8. In the DTM interface dialog select the OK button, to apply the selection
and to close the DTM interface dialog.

9. Put aright-click on the EtherCAT Slave device icon.
10. Select the Connect command from the context menu.

> The EtherCAT Slave device now is connected to the EtherCAT Slave
DTM via an online connection. In the network view the device
description at the device icon of the Slave is displayed with a green
colored background.
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Disconnecting Device

To disconnect an online connection from the EtherCAT Slave device to a
EtherCAT Slave DTM take the following steps:

1. In the DTM interface dialog select the OK button, to close the DTM
interface dialog.

Right-click on the EtherCAT Slave device icon.
Select the Disconnect command from the context menu.

w

2 In the network view the device description at the device icon of the
Slave is not any more displayed with a green colored background. Now
the EtherCAT Slave device is disconnected from the DTM.
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7.2 Download Configuration

The device configuration is created offline in the DTM (application
program). A download to the device is required, to transfer the configuration
with the parameter data to the device.

Note: To download configuration parameter data to the EtherCAT Slave
device an online connection from the EtherCAT Slave DTM to the
EtherCAT Slave device is required.

Further information can be found in the Connecting/Disconnecting Device
section on page 80.

Safety Precautions

Adhere to the necessary safety precautions to prevent personnel injury and
property damage that may occur in consequence of a communication stop
or in consequence of a mismatching system configuration.

| & WARNING |

Personnel Injury in Consequence of a Communication Stop
= Stop the application program before starting a configuration download.

= Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before downloading a configuration.

= Unexpected equipment operation may cause personal injury.

Personnel Injury as a result of mismatching System Configuration

= Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause personal injury.

NOTICE

Damage of Equipment and Loss of Device Parameters in
Consequence of a Communication Stop

= Stop the application program before starting a configuration download.

= Make sure that your equipment operates under conditions that prevent
property damage. All network devices should be placed in a fail-safe
mode before downloading a configuration.

= Unexpected equipment operation may cause property damage.

= Before you initiate a configuration download make sure that your current
project configuration data are saved non-volatile in order to prevent loss
of configuration data.

Damage of Equipment as a result of mismatching System
Configuration
= Mismatching system configuration loaded into the device could result in

faulty data mapping in the application program and thus unexpected
equipment operation may cause damage of equipment.
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Download Steps

To transfer the configuration with the corresponding parameter data to the
EtherCAT Slave device you download the data using the frame application
of the configuration software.

For netDevice the download is made via Device > Download or use the
context menu with Download.

1. Select Download in the context menu of the device.

2 If the download is started as long as the Slave devices are connected to
the Master device, the following message is displayed: ‘If you attempt to
download during bus operation, communication between Master and
Slaves is stopped. Do you really want to download?’

.
netDevice CIFX_DP_DPMICIFX DP/DPM]<1>(#1) - Download -

"-.I If you atternpt to download during bus operation, communication
W' between master and slaves is stopped
Do you really want to download?

-

Yes Mo

Figure 36: netDevice Message: Download

Important: If the communication between the Master and the Slave
devices is stopped, the data exchange between the Master device and the
Slave devices is stopped.

2. Click to Yes if you intend to download the configuration.

2 Then the current configuration in the application program is down
loaded to the device.

3. Otherwise click to No.
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8 Diagnosis

8.1 Overview Diagnosis

The dialog Diagnosis serves to diagnose the device behavior and
communication errors. For diagnosis the device must reside in online state.

Diagnosis Panes

The table below gives an overview for the individual Diagnosis dialog
panes descriptions:

EtherCAT Slave DTM Folder Name / Section Manual Page
E General Diagnosis 85

M avigation Area
= | Diagnosis
ey eneral Diagnosis
Firrmwate Diagnosis
[_7] Extended Diagnosis

Firmware Diagnosis 87

Navigation Area - Diagnosis

Table 36: Descriptions of the Diagnosis Panes

Online Connection to the Device

Note: Accessing the Diagnosis panes of the EtherCAT Slave DTM
requires an online connection from the EtherCAT Slave DTM to the
EtherCAT Slave device. For further information refer to section
Connecting/Disconnecting Device on page 80.

How to proceed

1. In the Slave DTM diagnosis dialog check whether the communication is
OK:

Diagnosis > General Diagnosis > Device status "Communication" must
be green!

2. "Communication" is green: Open the 10 Monitor and test the input or
output data..

3. "Communication"” is not green: Use Diagnosis and Extended
diagnosis for troubleshooting.

a

Extended Diagnosis

The Extended Diagnosis helps to find communication and configuration
errors, when default diagnosis fails. For further information refer to section
Overview Extended Diagnosis on page 88.

DTM for Hilscher EtherCAT Slave Device | Configuration of Hilscher Slave Devices
DOC1107020I04EN | Revision 4 | English | 2017-03 | Released | Public © Hilscher, 2012-2017



Diagnosis

85/125

8.2 General Diagnosis

Information regarding the Device State and other general diagnosis

parameters are displayed in the General Diagnosis dialog.

Device state Metwork, state
u Communication 9 Cperate
W run i) Idle
Ready 1_} Stop
i Erraor i) Offling
Configuration state
i) Configuration locked
'-J Mew configuration pending
iy Reset required
i Bus OM
Zammunication errar:
Wakchdog kime: 1000 ms
Error counk: i}
Figure 37: General Diagnosis
LED Meaning ‘ Color | State
Device State
Communication Shows whether the EtherCAT device executes the Q (green) In COMMUNICATION
network communication. state
Not in
@ (gray) COMMUNICATION state
Run Shows whether the EtherCAT device has been (W (green) Configuration OK
configured correctly.
Configuration not OK
& (gray) 9
Ready Shows whether the EtherCAT device has been (vellow) | Device READY
started correctly. The EtherCAT device waits for a -
configuration. .‘J (gray) Device not READY
Error Shows whether the EtherCAT device records a () (red) ERROR
device status error. For further information about the
error characteristics and the number of counted '-.) (gray) No ERROR
errors refer to the extended diagnosis. y
Network State
Operate Shows whether the EtherCAT device is in data Q (green) In OPERATION state
exchange. In a cyclic data exchange the input data
or the output data of the EtherCAT Slave are .‘J (gray) Not
transmitted to the EtherCAT Master. in OPERATION state
Idle Shows whether the EtherCAT device is in idle state. (yellow) |In IDLE state
k.) (gray) Not in IDLE state
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LED Meaning Color State
Stop Shows whether the EtherCAT device is in Stop ﬂ (red) In STOP state
state: There is no cyclic data exchange at the
EtherCAT network. The EtherCAT device was i (gray) Not in STOP state
stopped by the application program or it changed to
the Stop state because of a bus error.
Offline The EtherCAT Slave is offline as long as it does not (vellow) | In OFFLINE state
have a valid configuration.
.“} (gray) Not in OFFLINE state
Configuration State
Configuration Shows whether the EtherCAT device configuration (yellow) Configuration LOCKED
locked is locked, to avoid the configuration data are typed
over. .‘J ra Configuration not
@ay) | ocKkep
New Configura- Shows whether a new EtherCAT device (yellow) New Configuration
tion pending configuration is available. pending
.‘J No new Configuration
ra
(gray) pending
Reset required Shows whether a firmware reset is required as a (yellow) RESET required
new EtherCAT device configuration has been
loaded into the device. i (gray) No RESET required
Bus ON Shows whether the bus communication was started Q (green) Bus ON
or stopped. . e., whether the device is active on the
bus or no bus communication to the device is [ (gray) Bus OFF
possible and no response telegrams are sent.
Table 37: Indication General Diagnosis
Parameter Meaning

Communication Error

set to zero again.

Shows the name of the communication error. If the cause of error is resolved, the value will be

Watchdog time

Shows the watchdog time in ms.

Error Count

related or caused internally.

This field holds the total number of errors detected since power-up, respectively after reset.
The protocol stack counts all sorts of errors in this field no matter whether they were network

Table 38: Parameter General Diagnosis
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8.3 Firmware Diagnosis

In the dialog Firmware Diagnosis the current task information of the
firmware is displayed.

Under Firmware or Version the name of the firmware and version
(including the date) are indicated.

Firmware: EtherCAT Slave
Wersion: Z.5.0 (Build 16}
Date: 14.4.2011

Task inFarmation:

Task, | Mame of task, | Yersion | Prio | Description Skake

0 |[Rx IDLE R IDLE Task. Task Skabus ok, (0

1 Rus_TIMER. 1.0 1 ro Timer, Task Status ok, (0x00000000)

z R _SYSTEM 1.16 G Middleware Syskem Task, Task Status ok, (0x00000000)

3 DPM_COMO_SMEX 1.0 50  TLR-Router DPM, Task Status ok, (0x00000000)

4 DPM_COMO_RMEX 1.0 51 TLR-Roukter DPM, Task Status ok, (0x00000000)

5 ECAT_3DoO 2.9 3l EtherCAT ZoE SO0 Task, Task Status ok, (0x00000000)

& ECAT_COE 2.9 32 EtherCAT CoE Task, Task Status ok, (0x00000000)

7 ECAT_ESM 2.5 35 EtherCAT ESM Task. Slave is currently in skate INIT. {0x0020
a ECAT_MEX 2.5 34 EtherCAT Mailbox Task, Task is currently disabled. (000000001
q ECATDPM 2.5 36 EtherCAT Slave DPM Task, Task Status ok, (0x00000000)

10 MARSHALLER, 2.0 54  Marshaller: Main Task, Task Status ok, (0x00000000)

11 PACKET_ROUTER 2.0 49 Marshaller; Packet Router Task,  Task Status ok, (0x00000000)

< >

Figure 38: Firmware Diagnosis (Example)

Task Information:

The table Task Information is listing the task information of the single
firmware tasks.

Column Meaning

Task Task number

Name of task Name of the task

Version Version number of the task
Prio Priority of the task
Description Description of the task
Status Current status of the task

Table 39: Description Table Task Information
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9 Extended Diagnosis

9.1 Overview Extended Diagnosis

The Extended Diagnosis of the EtherCAT Slave DTM helps to find
communication and configuration errors. Therefore it contains a list of
diagnosis structures as online counter, states and parameters.

Dialog Panes “Extended Diagnosis”

The table below gives an overview for the Extended Diagnosis dialog
panes descriptions:

EtherCAT Slave DTM Folder Name in the Subsection Page
Navigation Area
Mavigation area = | RX-SYSTEM Task Information 89
3 Diagrosis IniBatch Status 90
General Diagnosis -
Firmware Diagnosis DPM_COMO_SMBX Task Information 89
= JExtended Diagnosis DPM_COMO_RMBX Task Information 89
3 R¥_SYSTEM -
i Task Information ECAT_SDO Task Information 89
InBatch Status ECAT_SDO_RSC _DIAG_T 91
IniBatch Status
IniBakch Skabus ECAT_SDO_RSC_TIMER_T 92
Inifiatch Status ECAT_COE Task Information 89
IniBatch Status -
IniBakch Stabus ECAT_ESM Task Information 89
{23 DPM_COMO_SMEX ECAT_ESM_RSC_DIAG_T 93
Task Information -
23 DPM_COMO_RMEX ECAT_MBX Task Information 89
Task Information ECAT_MBX_RSC_DIAG_T 94
S ECAT_SDO
Tsk Infarmation ECAT_MBX_RSC_TIMER_T 95
ECAT_3D0_R3C_DIAG_T ECAT_DPM Task Information 89
ECAT_SDO_RSC_TIMER_T -
23 ECAT COE MARSHALLER Task Information 89
Task Information PACKET_ROUTER Task Information 89
3 ECAT_ESM

Task Information
ECAT_ESM_RSC_DIAG_T
=3 ECAT_MBX
Task Information
ECAT_MBY_RSC_DIAG_T
ECAT_MBY_RSC_TIMER_T
=3 ECATDPM
Task Information
=3 MARSHALLER
Task Information
=3 PACKET _ROUTER
Task Information

Navigation Area - Extended
Diagnosis

Table 40: Descriptions of the Dialog Panes Extended Diagnosis

Online Connection to the Device

Note: Accessing the Extended Diagnosis dialog panes of the EtherCAT
Slave DTM requires an online connection from the EtherCAT Slave DTM
to the EtherCAT Slave device. For further information refer to section
Connecting/Disconnecting Device on page 80.
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9.2 Task Information

Task skates

Mame

Walue

Identifier

Major version

Minor wersion
Maxirmurn Packet size
Default Que

nique identifier

Init result

I'The displaved vaines depehd from the
corresponding task]

Figure 39: Extended Diagnosis > [Folder Name] > Task Information Example Display

Name

Description

Identifier

Identification number of the task

Major version

Task version, contains incompatible changes

Minor version

Task version, contains compatible changes

Maximum packet size

Maximum packet size, which the task sends

Default Queue

Queue handle, which is accessible via DPM by mailbox.

UuID Unique user ID, 16 Byte indicator used for task identification and its affiliation e. g. to a stack
(therein different identification data are coded in).
Init result Error Code, 0= no Error

The description of the error codes can be found in this manual or in the corresponding
software reference manuals.

Table 41: Extended Diagnosis > [Folder Name] > Task Information
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9.3

IniBatch Status

Task skates
Mame | Yalue
Zommunication Channel
Current Stake Errar
IniBatch Result ro DB file
OpenDbrm Fesult 24975
SendPacket Result 1]
Confirmation Resulk 1]
Last Packet Mumber 1]
Last Packet Cammand 1]
Last Packet Length 1]
Last Packet Destination 1]

Figure 40: Extended Diagnosis > [Folder Name] > IniBatch Status Example Display

Name

Description

Communication Channel

Number of the communication channel used by the device.

Current State

0 =ldle;
1 =IniBatch packets in progress;
2 =Retrying to send last packet;

3 = Error
IniBatch Result 0 =0k;
1 = No DBM file;

2 = No Packet table;

3 = No data set available;

4 = Data set is shorter than packet length;

5 = Packet Buffer is shorter than Packet length;
6 = Invalid packet destination;

7 = Logical queue not defined

8 = Send packet failed;

9 = Too many retries;

10 = Error in confirmation packet status

OpenDbm Result

Error when opening the IniBatch data base

file" (1) is.

Under "OpenDbm Result" the error code is typed in, when "IniBatch Result" == "No DBM

SendPacket Result

Error when sending a packet

packet failed" (8) is.

Under "SendPacket Result" the error code is typed in, when "IniBatch Result" == “send

Confirmation Result

Confirmation error when sending packets

"IniBatch Result " == "Error in confirmation packet status” (10) is.

Under "Confirmation Result" the packet specific error code from the ulSta is typed in, when

Last Packet Number

Value depends by the communication system.

Last Packet Command

Value depends by the communication system.

Last Packet Length

Value depends by the communication system.

Last Packet Destination

Value depends by the communication system.

Table 42: Extended Diagnosis > [Folder Name] > IniBatch Status

The task status "Confirmation Result" is bus specific. The other task

statuses are rcx-related error codes.
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9.4 ECAT SDO RSC DIAG T

Task states

ame Yalue

[

ulCompletedDownloadsServer
ulZompletedUploadsServer
ulCompletedDownloadsClient
ulZompletedUploadslient
uldbortedDownloadsServer
ulabortedploadsServer
ulnbortedDownloadsClisnt
ulabortedUploadsClient
ulserverTimeouts

ulClient Timeouts

oooo o ooog

Figure 41: Extended Diagnosis > [Folder Name] > ECAT_SDO_RSC_DIAG_T Example

Display

This window lists the diagnostic counters of the ECAT_SDO_RSC DIAG T
layer. It shows in particular, which services are currently executed. (The
services of the packets are described within the EtherCAT-Slave Protocol

API Manual [2].)

Name

Description

ulCompletedDownloadsServer

Counter for Completed Downloads at the Server

ulCompletedUploadsServer

Counter for Completed Uploads at the Server

ulCompletedDownloadsClient

Counter for Completed Downloads at the Client

ulCompletedUploadsClient

Counter for Completed Uploads at the Client

ulAbortedDownloadsServer

Counter for Aborted Downloads at the Server

ulAbortedUploadsServer

Counter for Aborted Uploads at the Server

ulAbortedDownloadsClient

Counter for Aborted Downloads at the Client

ulAbortedUploadsClient

Counter for Aborted Uploads at the Client

ulServerTimeouts

Counter for Server Timeouts

ulClientTimeouts

Counter for Client Timeouts

Table 43: Extended Diagnosis > [Folder Name] > ECAT_SDO_RSC_DIAG_T
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9.5 ECAT _SDO _RSC TIMER_T

Task stakes
Mame | Yalue
ulTimerCnk 8110100
ulTimerGran 100
ulSDOClient Tirmeouk 1000
ulsDi0Server Timeout 1000

Figure 42: Extended Diagnosis > [Folder Name] > ECAT_SDO_RSC_TIMER_T Example

Display
Name Description
ulTimerCnt Timer count
ulTimerGran Timer granularity

ulSDOClientTimeout

SDO Client Timeout

ulSDOServerTimeout

SDO Server Timeout

Table 44: Extended Diagnosis > [Folder Name] > ECAT_SDO_RSC_TIMER_T
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9.6 ECAT ESM_RSC DIAG T

Task states

Mame

Walue

ulR.eadyEits

ulSetInitBits
ulZorrectStatehanges
ullrvvalidatate”hanges
ulErrorstatehanges
ullrvvalidstateRequested
ulPatameterFailures
ulTimeoutStakehanges
ulalstatus

4294967295
32789
1

1]
0
0
0
0

INIT

Figure 43: Extended Diagnosis > [Folder Name] > ECAT_ESM_RSC_DIAG_T Example

Display

This window lists the diagnostic counters of the ECAT_ESM_RSC_DIAG_T
T layer. It shows in particular, which services are currently executed. (The
services of the packets are described within the EtherCAT-Slave Protocol

API Manual [2].)

Name Description
ulReadyBits Counter for Ready Bits
ulSetlnitBits Counter for Setlnit Bits

ulCorrectStateChanges

Counter for correct state changes

ullnvalidStateChanges

Counter for invalid state changes

ulErrorStateChanges

Counter for error state changes

ullnvalidStateRequested

Counter for requested invalid states

ulParameterFailures

Counter for parameter failures

ulTimeoutStateChanges

Counter for timeout state changes

ulAlStatus

AL Status according to EtherCAT Specification, part 5 and 6

Table 45: Extended Diagnosis > [Folder Name] > ECAT_ESM_RSC_DIAG_T
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9.7 ECAT_MBX_RSC_DIAG_T

Task states
[WE ‘alue
fEotPacketWaiting 0
FAckive

ulMessagesReceived
ulMessages3ent
ulMsgToolong

oo oo

Figure 44: Extended Diagnosis > [Folder Name] > ECAT_ESM_RSC_DIAG_T Example
Display

This window lists the diagnostic counters of the ECAT_MBX_RSC_DIAG_T
layer. It shows in particular, which services are currently executed. (The
services of the packets are described within the EtherCAT-Slave Protocol
API Manual [2].)

Name Description

fGotPacketWaiting If TRUE, a packet is still waiting

fActive If TRUE, the ECAT_MBX task is active
ulMessagesReceived Counter for number of received messages
ulMessagesSent Counter for number of sent messages
ulMsgToolLong Counter for number of too long messages

Table 46: Extended Diagnosis > [Folder Name] > ECAT_MBX_RSC_DIAG_T
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9.8 ECAT MBX_RSC_TIMER T

Task stakes

Mame Yalue
ulTirmeraran 50
uITirmerZnk 1]
UlLowTrafficTimeout 100

Figure 45: Extended Diagnosis > [Folder Name] > ECAT_MBX_RSC_TIMER_T Example

Display
Name Description
ulTimerGran Timer granularity
ulTimerCnt Timer count

ulLowtrafficTimeout

Low traffic timeout

Table 47: Extended Diagnosis > [Folder Name] > ECAT_MBX_RSC_TIMER_T
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10 Tools

10.1 Overview Tools

Under Tools the Packet Monitor and the IO Monitor are provided for test

and diagnosis purposes.

Tools Panes

The table below gives an overview for the individual Tools dialog panes

descriptions:

EtherCAT Slave DTM

Folder Name / Section

Manual Page

M avigation area =
D Diagnosis
[ Extended Diagnaosis
9 additional tools
(=¥ acket monitar
IO Manitor
Navigation Area - Tools

Packet Monitor
10 Monitor

97

100

Table 48: Descriptions of the Diagnosis Panes

Online Connection to the Device

Note: Accessing the Tools dialog panes of the EtherCAT Slave DTM
requires an online connection from the EtherCAT Slave DTM to the

EtherCAT Slave device.

For further

Connecting/Disconnecting Device on page 80.

information

refer

to section
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10.2 Packet Monitor

The Packet Monitor serves for test and diagnosis purposes.

Data packets, i. e. messages are self-contained blocks of defined data
length. The packets are used to communicate with the firmware and they
are exchanged between the application (configuration software) and the
firmware in the device. Packets can be sent once or cyclically to the
connected device controlled by the user and packets received can be
displayed.

Data packets comprise from a Packet Header and the Send Data or from
a Packet Header and the Receive Data. The packet header can be
evaluated by the receiver of the packet and contain the sender and receiver
address, the data length, an ID number, status and error messages and the
command or response code. The minimum packet size amounts 40 Byte
for the packet header. The sending and receiving data are added.

For further information to the packet description refer to the Protocol API
Manual.

» Open the Packet Monitor via Tools > Packet Monitor.

Display mode:  |Hexadecimal j

Send

Packet header Send data: Counter: 0

Disk: ||:||:||:||:||:||:||:||:| ﬂ 00 01|02 03|04 05|06 07 08 09|
i Goooooms Gonooooo {000 K.

Sk [l ufniuluuln} Skate: Qooooooo 0004

Dest ID: | 00000000 Crnd: 00000000 0014

SrcID: | 00000000 Exk: 00000000 ome
n0za
Len: Qoooona Rouk: oooooooa 003z
ID: Doo000o0 fuko Increment I0 W |003C b’
Puk cyilic | | Put packet

Receive
Facket header Receive data: Counker: 0

Desk: | 00 m 020304 05 08 07 02 03 ~

Skc: Skate: gggﬁ o

Desk 10 Zrnd: a4
Exck: 0mnE
R.ouk: ILEs

St ID:
Len:
10

no0zz

no3Cc w

Figure 46: Packet Monitor

Display Mode switches the representation of the send and reception data
between decimal and hexadecimal.

» Select Reset Counter to reset the packet counter.
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10.2.1 Sending Packet
Send
Packet header Send data: Counter: 0
Dest; | 00000001 | 2 (3 (4 5 [6[7 |89 [a
Src: Qooaoooo Stake: Qoooaooa
Dest ID: | QO0O0000 Crmd: O0o02Foa
Src ID: Qooaoooo Q0ooao0a
Lem: Im R.ouk: IM
I 00000001 Auto IncrementID W hd
Puk cylic | | Puk packet
Figure 47: Send > Packet Header and Send Data
Packet Header
Under Send > Packet Header the elements of the packet header of the
sending packet are displayed, which is transmitted from the application
(configuration software) to the device. The packet header of the sending
packets contain the elements described in the following table.
Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task
queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest Destination Queue Reference | Contains an identifier for the receiver of unsolicited sent packets from the
ID firmware to the application (configuration software).
Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in Bytes) | Length of the send respectively receive data.
ID Packet Identification As Identifies identical data packets among each other.
Unique Number
State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 49: Descriptions Packet Header

» Under Dest select the receiver (destination task queue).

» Under Cmd select the command identification (Request).

Auto Increment ID is an increment for the identifier of the data packets
and increments the ID by 1 for each newly sent packet.

Send Data

» Under Send > Send data enter the send data of the packet, which shall
be transmitted from the application (configuration software) to the
mailbox of the device. The meaning of the transmitted data depends on
the command or response code.
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Sending Packets once or cyclic
» To send packet once, select Put packet.
» To send packet cyclic, select Put cyclic.
10.2.2 Receiving Packet
Receive
Facket header Receive data: Counter; 0
Dest: | 00000001 0 J1 [2]3 [4 15 [6 |7 |8 |9 |4
Sect 0ooooooa Stake: |IIIIIIEIIIIIIIEIEIIII 0 #2000 00 00 00 00 00 00 00 04
10 |00 00 01 00 01 00 0o oo
Dest ID: | Q0000000 Crnd: |EIEIEIEIEFEII 20
Src I uluinlulnluinln] Exk: | u/uluulnululn] 30
Len: 0ooooo12 Rout: | 00o0aooa ;g
ID: 0000003E &0 3
Figure 48: Packet Header and Receive Data
Packet Header
Under Receive > Packet Header the elements of the packet header of the
receiving packet are displayed, which are transmitted back from the device
to the application (configuration software). The packet header of the
receiving packets contain the elements described in the following table.
Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task
queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest ID Destination Queue Reference | Contains an identifier for the receiver of unsolicited sent packets from
the firmware to the application (configuration software).
Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in Bytes) | Length of the send respectively receive data.
ID Packet Identification As Identifies identical data packets among each other.
Unique Number
State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 50: Descriptions Packet Header

Receive Data

Under Receive > Receive Data the receiving data of the packet, which is
transmitted back from the device to the application (configuration software)

are displayed.
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10.3 10 Monitor

The IO Monitor serves for test and diagnosis purposes. It provides to view
data of the process data image and to change output data easily. The
display is always in a Byte manner.

_) Note: Only change and write output data if you know that no plant
disturbances are caused by this. All output data written by the IO Monitor
are transmitted at the bus and have effect on subordinate drives, IO etc.

Caolumns: ﬂ Display mode:  |Decimal ﬂ

Intput data
Offset: 0 @0

iIS

=
=

10
20
a0
40

a0
i

s IR e Y e Y e Y e } D:K:';;_n.
o0 o O O O Ong
o0 O O O OOy
s N e e Y e I R s Y e SO
R e e Y e [ e Y e e R
oo o oo o oOm
e [ e R e N O s Y e P
s N e e Y e I e O s Y e
R e i e Y e [ e Y e R e T

0
0
0
0
0
n

Output data

Offsek: | 0 G0

0 0
20 0
30 0
40 0
1]
n

50
Fil

DDDDDDIEI_L
T e T s Y e s Y e Y e Y
s I T s e Y s I s Y s Y
oo oo o O O
R e s e ) e Y e Y e R
oo o oo o aOm
s I T s e Y I s Y s P
oo oo oo O m
R e s e ) e Y e Y e T

W

Update

Figure 49: 10 Monitor

Columns switches the number of columns.

Display mode switches the representation of the input and output data
between decimal and hexadecimal.

Offset / Go moves the indication of the data to the entered offset value.
» Enter the output value and select Update.

2 Always the data of the process image are displayed, also when these
Bytes have not been reserved by the configuration.
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11 Error Codes

11.1 Error Code Definition

For COM based application, like the ODM Server and ODM drivers, a
common error definition is used, similar to the Microsoft Windows®
HRESULT definition.

Error Code Structure:

COM Errors are HRESULTSs, which are 32 bit values using the following
layout:

3322222222221111111111
10987654321098765432109876543210

e e RS = +
|Sev|C|R] Facility | Code |
e e RS = +
where

Sev - is the severity code:

00 - Success
01 - Informational

10 - Warning

11 - Error
C - is the Customer code flag
R - is a reserved bit
Facility - is the facility code

Code

is the facility"s status code

In this common error definition, several error code regions are already
reserved by Windows® itself, the ODM and some other modules.
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11.2 Overview Error Codes

Overview Error Codes

Range

General Hardware Errors
RCX Operating System

RCX General Task: 0xC02B0001 to 0xC02B4D52

RCX Common Status & Errors Codes: 0x00000000 to 0xC002000C

RCX Status & Error Codes: 0x00000000 to 0OxC0000008

ODM Server General ODM Error Codes: 0x8004C700 to 0x8004C761
General ODM Driver Error Codes: 0x8004C7A0 to 0x8004C7C2
ODM Drivers cifX Driver Specific ODM Error: 0x8004C001 to 0x8004C0A4

cifX Device Driver
and netX Driver

Generic Error: 0x800A0001 bis 0x800A0017

Generic Driver Error: 0x800B0001 bisOx800B0042

Generic Device Error: 0x800C0010 bisOx800C0041

netX Driver CIFX API Transport: 0x800D0001 bis 0x800D0013
CIFX API Transport Header State Error: 0xX800E0001 bis 0xX800EO00B
DBM ODM Error Codes: 0xC004C810 to 0xC004C878

Table 51: Overview Error Codes and Ranges

corresponding protocol tasks.

~ The fieldbus specific error codes are described in the manuals of the
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11.3 General Hardware Error Codes

11.3.1 RCX General Task Errors

Error Code (Definition) Value Description
RCX_E_QUE_UNKNOWN 0xC02B0001 Unknown Queue
RCX_E_QUE_INDEX_UNKNOWN 0xC02B0002 Unknown Queue Index
RCX_E_TASK_UNKNOWN 0xC02B0003 Unknown Task
RCX_E_TASK_INDEX_UNKNOWN 0xC02B0004 Unknown Task Index
RCX_E_TASK_HANDLE_INVALID 0xC02B0005 Invalid Task Handle
RCX_E_TASK_INFO_IDX_UNKNOWN 0xC02B0006 Unknown Index
RCX_E_FILE_XFR_TYPE_INVALID 0xC02B0007 Invalid Transfer Type
RCX_E_FILE_REQUEST_INCORRECT 0xC02B0008 Invalid File Request
RCX_E_TASK_INVALID 0xC02B000E Invalid Task

RCX_E_SEC_FAILED 0xC02B001D Security EEPROM Access Failed
RCX_E_EEPROM_DISABLED 0xC02B001E EEPROM Disabled
RCX_E_INVALID_EXT 0xC02B0O01F Invalid Extension
RCX_E_SIZE_OUT_OF_RANGE 0xC02B0020 Block Size Out Of Range
RCX_E_INVALID_CHANNEL 0xC02B0021 Invalid Channel
RCX_E_INVALID_FILE_LEN 0xC02B0022 Invalid File Length
RCX_E_INVALID_CHAR_FOUND 0xC02B0023 Invalid Character Found
RCX_E_PACKET_OUT_OF_SEQ 0xC02B0024 Packet Out Of Sequence
RCX_E_SEC_NOT_ALLOWED 0xC02B0025 Not Allowed In Current State
RCX_E_SEC_INVALID_ZONE 0xC02B0026 Security EEPROM Invalid Zone
RCX_E_SEC_EEPROM_NOT_AVAIL 0xC02B0028 Security EEPROM Eeprom Not Available
RCX_E_SEC_INVALID_CHECKSUM 0xC02B0029 Security EEPROM Invalid Checksum
RCX_E_SEC_ZONE_NOT_WRITEABLE 0xC02B002A Security EEPROM Zone Not Writeable
RCX_E_SEC_READ_FAILED 0xC02B002B Security EEPROM Read Failed
RCX_E_SEC_WRITE_FAILED 0xC02B002C Security EEPROM Write Failed
RCX_E_SEC_ACCESS_DENIED 0xC02B002D Security EEPROM Access Denied
RCX_E_SEC_EEPROM_EMULATED 0xC02B002E Security EEPROM Emulated
RCX_E_INVALID_BLOCK 0xC02B0038 Invalid Block
RCX_E_INVALID_STRUCT_NUMBER 0xC02B0039 Invalid Structure Number
RCX_E_INVALID_CHECKSUM 0xC02B4352 Invalid Checksum
RCX_E_CONFIG_LOCKED 0xC02B4B54 Configuration Locked
RCX_E_SEC_ZONE_NOT_READABLE 0xC02B4D52 Security EEPROM Zone Not Readable

Table 52: RCX General Task Errors
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11.3.2 RCX Common Status & Errors Codes

Error Code (Definition) Value Description

RCX_S _OK 0x00000000 Success, Status Okay
RCX_E_FAIL 0xC0000001 Fail
RCX_E_UNEXPECTED 0xC0000002 Unexpected
RCX_E_OUTOFMEMORY 0xC0000003 Out Of Memory
RCX_E_UNKNOWN_COMMAND 0xC0000004 Unknown Command
RCX_E_UNKNOWN_DESTINATION 0xC0000005 Unknown Destination
RCX_E_UNKNOWN_DESTINATION_ID 0xC0000006 Unknown Destination ID
RCX_E_INVALID_PACKET_LEN 0xC0000007 Invalid Packet Length
RCX_E_INVALID_EXTENSION 0xC0000008 Invalid Extension
RCX_E_INVALID_PARAMETER 0xC0000009 Invalid Parameter
RCX_E_WATCHDOG_TIMEOUT 0xC000000C Watchdog Timeout
RCX_E_INVALID_LIST_TYPE 0xC000000D Invalid List Type
RCX_E_UNKNOWN_HANDLE 0xCOO00000E Unknown Handle
RCX_E_PACKET_OUT_OF_SEQ 0xCO000000F Out Of Sequence
RCX_E_PACKET_OUT_OF MEMORY 0xC0000010 Out Of Memory
RCX_E_QUE_PACKETDONE 0xC0000011 Queue Packet Done
RCX_E_QUE_SENDPACKET 0xC0000012 Queue Send Packet
RCX_E_POOL_PACKET_GET 0xC0000013 Pool Packet Get
RCX_E_POOL_GET_LOAD 0xC0000015 Pool Get Load
RCX_E_REQUEST_RUNNING 0xCO000001A Request Already Running
RCX_E_INIT_FAULT 0xC0000100 Initialization Fault
RCX_E_DATABASE_ACCESS_FAILED 0xC0000101 Database Access Failed
RCX_E_NOT_CONFIGURED 0xC0000119 Not Configured
RCX_E_CONFIGURATION_FAULT 0xC0000120 Configuration Fault
RCX_E_INCONSISTENT_DATA_SET 0xC0000121 Inconsistent Data Set
RCX_E_DATA_SET_MISMATCH 0xC0000122 Data Set Mismatch
RCX_E_INSUFFICIENT_LICENSE 0xC0000123 Insufficient License
RCX_E_PARAMETER_ERROR 0xC0000124 Parameter Error
RCX_E_INVALID_NETWORK_ADDRESS 0xC0000125 Invalid Network Address
RCX_E_NO_SECURITY_MEMORY 0xC0000126 No Security Memory
RCX_E_NETWORK_FAULT 0xC0000140 Network Fault
RCX_E_CONNECTION_CLOSED 0xC0000141 Connection Closed
RCX_E_CONNECTION_TIMEOUT 0xC0000142 Connection Timeout
RCX_E_LONELY_NETWORK 0xC0000143 Lonely Network
RCX_E_DUPLICATE_NODE 0xC0000144 Duplicate Node
RCX_E_CABLE_DISCONNECT 0xC0000145 Cable Disconnected
RCX_E_BUS_OFF 0xC0000180 Network Node Bus Off
RCX_E_CONFIG_LOCKED 0xC0000181 Configuration Locked
RCX_E_APPLICATION_NOT_READY 0xC0000182 Application Not Ready
RCX_E_TIMER_APPL_PACKET_SENT 0xC002000C Timer App Packet Sent

Table 53: RCX Common Status & Errors Codes
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11.3.3 RCX Status & Error Codes

Error Code (Definition) Value Description

RCX_S_OK 0x00000000 SUCCESS, STATUS OKAY
RCX_S_QUE_UNKNOWN 0xC02B0001 UNKNOWN QUEUE
RCX_S_QUE_INDEX_UNKNOWN 0xC02B0002 UNKNOWN QUEUE INDEX
RCX_S_TASK_UNKNOWN 0xC02B0003 UNKNOWN TASK
RCX_S_TASK_INDEX_UNKNOWN 0xC02B0004 UNKNOWN TASK INDEX
RCX_S_TASK_HANDLE_INVALID 0xC02B0005 INVALID TASK HANDLE
RCX_S_TASK_INFO_IDX_UNKNOWN 0xC02B0006 UNKNOWN INDEX
RCX_S_FILE_XFR_TYPE_INVALID 0xC02B0007 INVALID TRANSFER TYPE
RCX_S_FILE_REQUEST_INCORRECT 0xC02B0008 INVALID FILE REQUEST
RCX_S_UNKNOWN_DESTINATION 0xC0000005 UNKNOWN DESTINATION
RCX_S_UNKNOWN_DESTINATION_ID 0xC0000006 UNKNOWN DESTINATION ID
RCX_S_INVALID_LENGTH 0xC0000007 INVALID LENGTH
RCX_S_UNKNOWN_COMMAND 0xC0000004 UNKNOWN COMMAND
RCX_S_INVALID_EXTENSION 0xC0000008 INVALID EXTENSION

Table 54: RCX Status & Error Codes

11.3.3.1 RCX Status & Error Codes Slave State

Error Code (Definition) Value Description
RCX_SLAVE_STATE_UNDEFINED 0x00000000 UNDEFINED
RCX_SLAVE_STATE_OK 0x00000001 OK
RCX_SLAVE_STATE_FAILED 0x00000002 FAILED (at least one slave)

Table 55: RCX Status & Error Codes Slave State
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11.4 ODM Error Codes

11.4.1 General ODM Error Codes

Error Code (Definition) Value Description
CODMS3_E_INTERNALERROR 0x8004C700 Internal ODM Error
ODM3_E_DESCRIPTION_NOTFOUND 0x8004C701 Description not found in ODM database
CODM3_E_WRITEREGISTRY 0x8004C710 Error writing to the registry
CODM3_E_BAD_REGULAR_EXPRESSION 0x8004C711 Invalid regular expression
CODM3_E_COMCATEGORIE_MANAGER_ 0x8004C712 Component Category Manager could not
FAILED be instantiated
CODM3_E_COMCATEGORIE_ENUMERATION_ 0x8004C713 Driver could not be enumerated by the
FAILED Category Manager
CODM3_E_CREATE_LOCAL_BUFFER 0x8004C714 Error creating local buffers
CODM3_E_UNKNOWNHANDLE 0x8004C715 Unknown handle
CODM3_E_QUEUE_LIMIT_REACHED 0x8004C717 Queue size limit for connection reached
CODM3_E_DATASIZE_ZERO 0x8004C718 Zero data length passed
CODMS3_E_INVALID_DATA 0x8004C719 Invalid data content
CODM3_E_INVALID_MODE 0x8004C71A Invalid mode
CODM3_E_DATABASE_READ 0x8004C71B Error reading database
CODM3_E_CREATE_DEVICE_THREAD 0x8004C750 Error creating device thread
CODM3_E_CREATE_DEVICE_THREAD_STOP_ 0x8004C751 Error creating device thread stop event
EVENT
CODM3_E_CLIENT_NOT_REGISTERED 0x8004C752 Client is not registered at the ODM
CODM3_E_NO_MORE_CLIENTS 0x8004C753 Maximum number of clients reached
CODM3_E_MAX_CLIENT_CONNECTIONS _ 0x8004C754 Maximum number of client connections
REACHED reached
CODM3_E_ENTRY_NOT_FOUND 0x8004C755 Driver/device not found
CODM3_E_DRIVER_NOT_FOUND 0x8004C757 The requested driver is unknown to the
ODM
CODM3_E_DEVICE_ALREADY_LOCKED 0x8004C758 Device is locked by another process
CODM3_E_DEVICE_UNLOCKED_FAILED 0x8004C759 Device could not be unlocked, lock was
set by another process
CODM3_E_DEVICE_LOCK_NECCESSARY 0x8004C75A Operation requires a device lock to be set
CODM3_E_DEVICE_SUBSCRIPTIONLIMIT 0x8004C75B Maximum number of servers registered for
this device reached
CODM3_E_DEVICE_NOTSUBSCRIBED 0x8004C75C Process is not registered as a server on
this device
CODM3_E_DEVICE_NO_MESSAGE 0x8004C75D No message available
CODM3_E_TRANSFERTIMEOUT 0x8004C760 Message transfer timeout
CODM3_E_MESSAGE_INSERVICE 0x8004C761 Message in service

Table 56: ODM Error Codes - General ODM Error Codes
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11.4.2 General ODM Driver Error Codes

Error Code (Definition) Value Description
CODM3_E_DRV_OPEN_DEVICE 0x8004C7A0 Packet type unsupported by driver
CODM3_E_DRV_INVALID_IDENTIFIER 0x8004C7A1 Invalid device identifier
CODM3_E_DRV_DEVICE_PARAMETERS _ 0x8004C7A3 Parameters differ from requested device
MISMATCH

CODM3_E_DRV_BROWSE_NO_DEVICES 0x8004C7A4 No devices found
CODM3_E_DRV_CREATE_DEVICE_INST 0x8004C7A5 Device instance could not be created
CODM3_E_DRV_DEVICE_NOMORE_TX 0x8004C7A6 Device connection limit reached
CODM3_E_DRV_DEVICE_DUPLICATE_TX 0x8004C7A7 Duplicate transmitter ID
CODM3_E_DRV_DEVICE_NOT_CONFIGURED 0x8004C7A8 Device is not configured
CODM3_E_DRV_DEVICE_COMMUNICATION 0x8004C7A9 Device communication error
CODM3_E_DRV_DEVICE_NO_MESSAGE 0x8004C7AA No message available
CODM3_E_DRV_DEVICE_NOT_READY 0x8004C7AB Device not ready
CODM3_E_DRV_INVALIDCONFIGURATION 0x8004C7AC Invalid driver configuration
CODM3_E_DRV_DLINVALIDMODE 0x8004C7CO Invalid download mode
CODM3_E_DRV_DLINPROGRESS 0x8004C7C1 Download is active
CODM3_E_DRV_ULINPROGRESS 0x8004C7C2 Upload is active

Table 57: ODM Error Codes - General ODM Driver Error Codes
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11.4.3

cifX Driver Specific ODM Error Codes

cifX Driver Specific ODM Error Codes

Error Code (Definition) Value Description
DRV_E_BOARD_NOT_INITIALIZED 0x8004C001 DRIVER Board not initialized
DRV_E_INIT_STATE_ERROR 0x8004C002 DRIVER Error in internal init state
DRV_E_READ_STATE_ERROR 0x8004C003 DRIVER Error in internal read state
DRV_E_CMD_ACTIVE 0x8004C004 DRIVER Command on this channel is
active
DRV_E_PARAMETER_UNKNOWN 0x8004C005 DRIVER Unknown parameter in function
DRV_E_WRONG_DRIVER_VERSION 0x8004C006 DRIVER Version is incompatible with DLL
DRV_E_PCI_SET_CONFIG_MODE 0x8004C007 DRIVER Error during PCI set configuration
mode
DRV_E_PCI_READ_DPM_LENGTH 0x8004C008 DRIVER Could not read PCI dual port
memory length
DRV_E_PCI_SET_RUN_MODE 0x8004C009 DRIVER Error during PCI set run mode
DRV_E_DEV_DPM_ACCESS_ERROR 0x8004C00A DEVICE Dual port ram not
accessable(board not found)
DRV_E_DEV_NOT_READY 0x8004C00B DEVICE Not ready (ready flag failed)
DRV_E_DEV_NOT_RUNNING 0x8004C00C DEVICE Not running (running flag failed)
DRV_E_DEV_WATCHDOG_FAILED 0x8004C00D DEVICE Watchdog test failed
DRV_E_DEV_OS_VERSION_ERROR 0x8004CO0O0E DEVICE Signals wrong OS version
DRV_E_DEV_SYSERR 0x8004CO0F DEVICE Error in dual port flags
DRV_E_DEV_MAILBOX_FULL 0x8004C010 DEVICE Send mailbox is full
DRV_E_DEV_PUT_TIMEOUT 0x8004C011 DEVICE PutMessage timeout
DRV_E_DEV_GET_TIMEOUT 0x8004C012 DEVICE GetMessage timeout
DRV_E_DEV_GET_NO_MESSAGE 0x8004C013 DEVICE No message available
DRV_E_DEV_RESET_TIMEOUT 0x8004C014 DEVICE RESET command timeout
DRV_E_DEV_NO_COM_FLAG 0x8004C015 DEVICE COM-flag not set. Check if Bus is
running
DRV_E_DEV_EXCHANGE_FAILED 0x8004C016 DEVICE I/O data exchange failed
DRV_E_DEV_EXCHANGE_TIMEOUT 0x8004C017 DEVICE 1/O data exchange timeout
DRV_E_DEV_COM_MODE_UNKNOWN 0x8004C018 DEVICE 1/O data mode unknown
DRV_E_DEV_FUNCTION_FAILED 0x8004C019 DEVICE Function call failed
DRV_E_DEV_DPMSIZE_MISMATCH 0x8004CO01A DEVICE DPM size differs from
configuration
DRV_E_DEV_STATE_MODE_UNKNOWN 0x8004C01B DEVICE State mode unknown
DRV_E_DEV_HW_PORT_IS_USED 0x8004C01C DEVICE Output port already in use
DRV_E_USR_OPEN_ERROR 0x8004CO1E USER Driver not opened (device driver not
loaded)
DRV_E_USR_INIT_DRV_ERROR 0x8004CO1F USER Can't connect to device
DRV_E_USR_NOT_INITIALIZED 0x8004C020 USER Board not initialized (DevinitBoard
not called)
DRV_E_USR_COMM_ERR 0x8004C021 USER IOCTRL function failed
DRV_E_USR_DEV_NUMBER_INVALID 0x8004C022 USER Parameter DeviceNumber invalid
DRV_E_USR_INFO_AREA_INVALID 0x8004C023 USER Parameter InfoArea unknown
DRV_E_USR_NUMBER_INVALID 0x8004C024 USER Parameter Number invalid
DRV_E_USR_MODE_INVALID 0x8004C025 USER Parameter Mode invalid
DRV_E_USR_MSG_BUF_NULL_PTR 0x8004C026 USER NULL pointer assignment
DRV_E_USR_MSG_BUF_TOO_SHORT 0x8004C027 USER Message buffer too small
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cifX Driver Specific ODM Error Codes

Error Code (Definition) Value Description
DRV_E_USR_SIZE_INVALID 0x8004C028 USER Parameter Size invalid
DRV_E_USR_SIZE_ZERO 0x8004C02A USER Parameter Size with zero length
DRV_E_USR_SIZE_TOO_LONG 0x8004C02B USER Parameter Size too long
DRV_E_USR_DEV_PTR_NULL 0x8004C02C USER Device address null pointer
DRV_E_USR_BUF_PTR_NULL 0x8004C02D USER Pointer to buffer is a null pointer
DRV_E_USR_SENDSIZE_TOO_LONG 0x8004CO02E USER Parameter SendSize too large
DRV_E_USR_RECVSIZE_TOO_LONG 0x8004CO2F USER Parameter ReceiveSize too large
DRV_E_USR_SENDBUF_PTR_NULL 0x8004C030 USER Pointer to send buffer is a null
pointer
DRV_E_USR_RECVBUF_PTR_NULL 0x8004C031 USER Pointer to receive buffer is a null
pointer
DRV_E_DMA_INSUFF_MEM 0x8004C032 DMA Memory allocation error
DRV_E_DMA_TIMEOUT_CH4 0x8004C033 DMA Read I/O timeout
DRV_E_DMA_TIMEOUT_CH5 0x8004C034 DMA Write 1/O timeout
DRV_E_DMA_TIMEOUT_CH®6 0x8004C035 DMA PCI transfer timeout
DRV_E_DMA_TIMEOUT_CH7 0x8004C036 DMA Download timeout
DRV_E_DMA_DB_DOWN_FAIL 0x8004C037 DMA Database download failed
DRV_E_DMA_FW_DOWN_FAIL 0x8004C038 DMA Firmware download failed
DRV_E_CLEAR_DB_FAIL 0x8004C039 DMA Clear database on the device failed
DRV_E_DEV_NO_VIRTUAL_MEM 0x8004C03C DMA USER Virtual memory not available
DRV_E_DEV_UNMAP_VIRTUAL_MEM 0x8004C03D DMA USER Unmap virtual memory failed
DRV_E_GENERAL_ERROR 0x8004C046 DRIVER General error
DRV_E_DMA_ERROR 0x8004C047 DRIVER General DMA error
DRV_E_WDG_IO_ERROR 0x8004C048 DRIVER I/0 WatchDog failed
DRV_E_WDG_DEV_ERROR 0x8004C049 DRIVER Device Watchdog failed
DRV_E_USR_DRIVER_UNKNOWN 0x8004C050 USER Driver unknown
DRV_E_USR_DEVICE_NAME_INVALID 0x8004C051 USER Device name invalid
DRV_E_USR_DEVICE_NAME_UKNOWN 0x8004C052 USER Device name unknown
DRV_E_USR_DEVICE_FUNC_NOTIMPL 0x8004C053 USER Device function not implemented
DRV_E_USR_FILE_OPEN_FAILED 0x8004C064 USER File could not be opened
DRV_E_USR_FILE_SIZE_ZERO 0x8004C065 USER File size zero
DRV_E_USR_FILE_NO_MEMORY 0x8004C066 USER Not enough memory to load file
DRV_E_USR_FILE_READ_FAILED 0x8004C067 USER File read failed
DRV_E_USR_INVALID_FILETYPE 0x8004C068 USER File type invalid
DRV_E_USR_FILENAME_INVALID 0x8004C069 USER Invalid filename
DRV_E_FW_FILE_OPEN_FAILED 0x8004C0O6E USER Firmware file could not be opened
DRV_E_FW_FILE_SIZE_ZERO 0x8004C06F USER Not enough memory to load
firmware file
DRV_E_FW_FILE_NO_MEMORY 0x8004C070 USER Not enough memory to load
firmware file
DRV_E_FW_FILE_READ_FAILED 0x8004C071 USER Firmware file read failed
DRV_E_FW_INVALID_FILETYPE 0x8004C072 USER Firmware file type invalid
DRV_E_FW_FILENAME_INVALID 0x8004C073 USER Firmware file name not valid
DRV_E_FW_DOWNLOAD_ERROR 0x8004C074 USER Firmware file download error
DRV_E_FW_FILENAME_NOT_FOUND 0x8004C075 USER Firmware file not found in the
internal table
DRV_E_FW_BOOTLOADER_ACTIVE 0x8004C076 USER Firmware file BOOTLOADER active
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cifX Driver Specific ODM Error Codes

Error Code (Definition) Value Description
DRV_E_FW_NO_FILE_PATH 0x8004C077 USER Firmware file no file path
DRV_E_CF_FILE_OPEN_FAILED 0x8004C078 USER Configuration file could not be
opend
DRV_E_CF_FILE_SIZE_ZERO 0x8004C079 USER Configuration file size zero
DRV_E_CF_FILE_NO_MEMORY 0x8004CO7A USER Not enough memory to load
configuration file
DRV_E_CF_FILE_READ_FAILED 0x8004C07B USER Configuration file read failed
DRV_E_CF_INVALID_FILETYPE 0x8004C07C USER Configuration file type invalid
DRV_E_CF_FILENAME_INVALID 0x8004C07D USER Configuration file name not valid
DRV_E_CF_DOWNLOAD_ERROR 0x8004CO7E USER Configuration file download error
DRV_E_CF_FILE_NO_SEGMENT 0x8004CO7F USER No flash segment in the
configuration file
DRV_E_CF_DIFFERS_FROM_DBM 0x8004C080 USER Configuration file differs from
database
DRV_E_DBM_SIZE_ZERO 0x8004C083 USER Database size zero
DRV_E_DBM_NO_MEMORY 0x8004C084 USER Not enough memory to upload
database
DRV_E_DBM_READ_FAILED 0x8004C085 USER Database read failed
DRV_E_DBM_NO_FLASH_SEGMENT 0x8004C086 USER Database segment unknown
DEV_E_CF_INVALID_DESCRIPT_VERSION 0x8004C096 CONFIG Version of the descript table
invalid
DEV_E_CF_INVALID_INPUT_OFFSET 0x8004C097 CONFIG Input offset is invalid
DEV_E_CF_NO_INPUT_SIZE 0x8004C098 CONFIG Input size is 0
DEV_E_CF_MISMATCH_INPUT_SIZE 0x8004C099 CONFIG Input size does not match
configuration
DEV_E_CF_INVALID_OUTPUT_OFFSET 0x8004C09A CONFIG Invalid output offset
DEV_E_CF_NO_OUTPUT_SIZE 0x8004C09B CONFIG Output size is 0
DEV_E_CF_MISMATCH_OUTPUT_SIZE 0x8004C09C CONFIG Output size does not match
configuration
DEV_E_CF_STN_NOT_CONFIGURED 0x8004C09D CONFIG Station not configured
DEV_E_CF_CANNOT_GET_STN_CONFIG 0x8004C09E CONFIG Cannot get the Station
configuration
DEV_E_CF_MODULE_DEF_MISSING 0x8004C09F CONFIG Module definition is missing
DEV_E_CF_MISMATCH_EMPTY_SLOT 0x8004C0A0 CONFIG Empty slot mismatch
DEV_E_CF_MISMATCH_INPUT_OFFSET 0x8004C0A1 CONFIG Input offset mismatch
DEV_E_CF_MISMATCH_OUTPUT_OFFSET 0x8004C0A2 CONFIG Output offset mismatch
DEV_E_CF_MISMATCH_DATA_TYPE 0x8004CO0A3 CONFIG Data type mismatch
DEV_E_CF_MODULE_DEF_MISSING_NO_SI 0x8004C0A4 CONFIG Module definition is missing,(no

Slot/ldx)
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11.5 Error Codes cifX Device Driver and netX Driver

11.5.1 Generic Error Codes
Error Code (Definition) Value Description
CIFX_INVALID_POINTER 0x800A0001L Invalid pointer (NULL) passed to driver
CIFX_INVALID_BOARD 0x800A0002L No board with the given nameindex

available
CIFX_INVALID_CHANNEL 0x800A0003L No channel with the given index
available

CIFX_INVALID_HANDLE 0x800A0004L Invalid handle passed to driver
CIFX_INVALID_PARAMETER 0x800A0005L Invalid parameter
CIFX_INVALID_COMMAND 0x800A0006L Invalid command
CIFX_INVALID_BUFFERSIZE 0x800A0007L Invalid buffer size
CIFX_INVALID_ACCESS_SIZE 0x800A0008L Invalid access size
CIFX_FUNCTION_FAILED 0x800A0009L Function failed
CIFX_FILE_OPEN_FAILED 0x800A000AL File could not be opened
CIFX_FILE_SIZE_ZERO 0x800A000BL File size is zero
CIFX_FILE_LOAD_INSUFF_MEM 0x800A000CL Insufficient memory to load file
CIFX_FILE_CHECKSUM_ERROR 0x800A000DL File checksum compare failed
CIFX_FILE_READ_ERROR 0x800A000EL Error reading from file
CIFX_FILE_TYPE_INVALID 0x800A000FL Invalid file type
CIFX_FILE_NAME_INVALID 0x800A0010L Invalid file name
CIFX_FUNCTION_NOT_AVAILABLE 0x800A0011L Driver function not available
CIFX_BUFFER_TOO_SHORT 0x800A0012L Given buffer is too short
CIFX_MEMORY_MAPPING_FAILED 0x800A0013L Failed to map the memory
CIFX_NO_MORE_ENTRIES 0x800A0014L No more entries available
CIFX_CALLBACK_MODE_UNKNOWN 0x800A0015L Unkown callback handling mode
CIFX_CALLBACK_CREATE_EVENT_FAILED | Ox800A0016L Failed to create callback events
CIFX_CALLBACK_CREATE_RECV_BUFFER 0x800A0017L Failed to create callback receive buffer

Table 59: Generic Error Codes
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11.5.2 Generic Driver Error Codes

Error Code (Definition) Value Description
CIFX_DRV_NOT_INITIALIZED 0x800B0001L Driver not initialized
CIFX_DRV_INIT_STATE_ERROR 0x800B0002L Driver init state error
CIFX_DRV_READ_STATE_ERROR 0x800B0003L Driver read state error
CIFX_DRV_CMD_ACTIVE 0x800B0004L Command is active on device
CIFX_DRV_DOWNLOAD_FAILED 0x800B000O5L General error during download
CIFX_DRV_WRONG_DRIVER_VERSION 0x800B000O6L Wrong driver version
CIFX_DRV_DRIVER_NOT_LOADED 0x800B0030L CIFx driver is not running
CIFX_DRV_INIT_ERROR 0x800B0031L Failed to initialize the device
CIFX_DRV_CHANNEL_NOT_INITIALIZED 0x800B0032L Channel not initialized (xOpenChannel
not called)
CIFX_DRV_IO_CONTROL_FAILED 0x800B0033L I0Control call failed
CIFX_DRV_NOT_OPENED( 0x800B0034L Driver was not opened
CIFX_DRV_DOWNLOAD_STORAGE_UNKN 0x800B0040L Unknown download storage type
OWN (RAMFLASH based) found
CIFX_DRV_DOWNLOAD_FW_WRONG_CHA | 0x800B0041L Channel number for a firmware
NNEL download not supported
CIFX_DRV_DOWNLOAD_MODULE_NO_BAS | 0x800B0042L Modules are not allowed without a Base

EOS

OS firmware

Table 60: Generic Driver Error Codes
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11.5.3 Generic Device Error Codes

Error Code (Definition) Value Description
CIFX_DEV_DPM_ACCESS_ERROR 0x800C0010L Dual port memory not accessable
(board not found)
CIFX_DEV_NOT_READY 0x800C0011L Device not ready (ready flag failed)
CIFX_DEV_NOT_RUNNING 0x800C0012L Device not running (running flag failed)
CIFX_DEV_WATCHDOG_FAILED 0x800C0013L Watchdog test failed
CIFX_DEV_SYSERR 0x800C0015L Error in handshake flags
CIFX_DEV_MAILBOX_FULL 0x800C0016L Send mailbox is full
CIFX_DEV_PUT_TIMEOUT 0x800C0017L Send packet timeout
CIFX_DEV_GET_TIMEOUT 0x800C0018L Receive packet timeout
CIFX_DEV_GET_NO_PACKET 0x800C0019L No packet available
CIFX_DEV_MAILBOX_TOO_SHORT 0x800CO01AL Mailbox too short
CIFX_DEV_RESET_TIMEOUT 0x800C0020L Reset command timeout
CIFX_DEV_NO_COM_FLAG 0x800C0021L COM-flag not set
CIFX_DEV_EXCHANGE_FAILED 0x800C0022L 10 data exchange failed
CIFX_DEV_EXCHANGE_TIMEOUT 0x800C0023L 10 data exchange timeout
CIFX_DEV_COM_MODE_UNKNOWN 0x800C0024L Unknown IO exchange mode
CIFX_DEV_FUNCTION_FAILED 0x800C0025L Device function failed
CIFX_DEV_DPMSIZE_MISMATCH 0x800C0026L DPM size differs from configuration
CIFX_DEV_STATE_MODE_UNKNOWN 0x800C0027L Unknown state mode
CIFX_DEV_HW_PORT_IS_USED 0x800C0028L Device is still accessed
CIFX_DEV_CONFIG_LOCK_TIMEOUT 0x800C0029L Configuration locking timeout
CIFX_DEV_CONFIG_UNLOCK_TIMEOUT 0x800C002AL Configuration unlocking timeout
CIFX_DEV_HOST_STATE_SET_TIMEOUT 0x800C002BL Set HOST state timeout
CIFX_DEV_HOST_STATE_CLEAR_TIMEOUT | 0x800C002CL Clear HOST state timeout
CIFX_DEV_INITIALIZATION_TIMEOUT 0x800C002DL Timeout during channel initialization
CIFX_DEV_BUS_STATE_ON_TIMEOUT 0x800C0O02EL Set Bus ON Timeout
CIFX_DEV_BUS_STATE_OFF_TIMEOUT 0x800C002FL Set Bus OFF Timeout
CIFX_DEV_MODULE_ALREADY_RUNNING 0x800C0040L Module already running
CIFX_DEV_MODULE_ALREADY_EXISTS 0x800C0041L Module already exists

Table 61: Generic Device Error Codes
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11.6 Error Codes netX Driver

11.6.1 CIFX API Transport Error Codes

Error Code (Definition) Value Description
CIFX_TRANSPORT_SEND_TIMEOUT 0x800D0001L Time out while sending data
CIFX_TRANSPORT_RECV_TIMEOUT 0x800D0002L Time out waiting for incoming data
CIFX_TRANSPORT_CONNECT 0x800D0003L Unable to communicate to the deviceno
answer
CIFX_TRANSPORT_ABORTED 0x800D0004L Transfer has been aborted due to keep

alive timeout or interface detachment

CIFX_CONNECTOR_FUNCTIONS_READ_ERR | 0x800D0010L

OR

Error reading the connector functions
from the DLL

CIFX_CONNECTOR_IDENTIFIER_TOO_LONG | 0x800D0011L

Connector delivers an identifier longer
than 6 characters

CIFX_CONNECTOR_IDENTIFIER_EMPTY

0x800D0012L

Connector delivers an empty dentifier

CIFX_CONNECTOR_DUPLICATE_IDENTIFIER | 0x800D0013L

Connector identifier already used

Table 62: CIFX API Transport Error Codes

11.6.2 CIFX API Transport Header State Error Codes

Error Code (Definition) Value Description
CIFX_TRANSPORT_ERROR_UNKNOWN 0x800E0001L Unknown error code in transport header
CIFX_TRANSPORT_CHECKSUM_ERROR 0x800E0002L CRC16 checksum failed
CIFX_TRANSPORT_LENGTH_INCOMPLETE | Ox800E0003L Transaction with inclomplete length
detected
CIFX_TRANSPORT_DATA_TYPE_UNKOWN 0x800E0004L Device does not support requested data
type
CIFX_TRANSPORT_DEVICE_UNKNOWN 0x800E0005L Device not availableunknown
CIFX_TRANSPORT_CHANNEL_UNKNOWN 0x800E0006L Channel not availableunknown
CIFX_TRANSPORT_SEQUENCE 0Ox800EO0007L Sequence error detected
CIFX_TRANSPORT_BUFFEROVERFLOW 0x800E0008L Buffer overflow detected
CIFX_TRANSPORT_RESOURCE 0x800E0009L Device signals out of resources
CIFX_TRANSPORT_KEEPALIVE Ox800EO00OAL Device connection monitoring error
(Keep alive)
CIFX_TRANSPORT_DATA_TOO_SHORT( 0x800E000BL Received transaction data too short

Table 63: CIFX API Transport Header State Error Codes
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11.7 ODM Error Codes DBM V4

ODM Error Codes DBM V4

Error Code (Definition) Value Description
CDBM_E_MDS5_INVALID 0XC004C810 Checksum invalid
CDBM_E_INTERNALERROR 0XC004C811 Internal Error
CDBM_W_WRITEREGISTRY 0X8004C812 Error writing to the registry
CDBM_E_UNEXPECTED_VALUE_ 0XC004C813 Error in a file containing the old DBM
IN_OLD_HEADER_FORMAT Header format.
CDBM_E_CHECKSUM_INVALID 0XC004C814 The Checksum of the old Header is invalid
CDBM_E_DB_ALREADY_LOADED_ FORMAT 0XC004C815 A database is already loaded
CDBM_E_NO_VALID_TRANSACTION 0XC004C816 No valid transaction handle given
CDBM_E_STD_STRUCT_ERROR 0XCo04C817 An error occurred during validation of data
CDBM_E_UNSUPPORTED_ 0XC004C818 Unsupported DataType
DATA_TYPE_FORMAT
CDBM_W_CLASS_DELETED_ FORMAT 0X8004C819 Using an Object which is marked as
(Warning) deleted
CDBM_W_CLIENT_DISCONNECTED 0X8004C81A A CIient.has already an outstanding .
(Warning) ﬁcc))cvng(ég?rg;gde? Table. The connection is
CDBM_E_STRUCTURE_DEFINITION_ INVALID 0XC004C81B A structure definition of an Element in a
Table is invalid
CDBM_E_NO_DATA_AVAILABLE 0Xxcoo4csic No data available for this operation
CDBM_E_NO_VALID_STRUCTURE 0XC004C81D No valid structure available for this
operation
CDBM_E_NO_TOGGLE_STRING_ FOUND 0XCO004C81E No Toggle string found for this number
CDBM_E_ELEMENT_OUT_OF_RANGE 0XCO004C81F An element wasn’t found in the Record of
a Table
CDBM_E_ELEMENT_NOT_IN_ TABLE 0XC004C820 The element is not part of the Table
CDBM_E_CANNOT_CONVERT_ 0XC004C821 The data can't be converted into the Client
INTO_CLIENT_TYPE type
CDBM_E_TRANSACTION_ ALREADY_OPEN 0XC004C822 A transaction is already open. Please
close this one first before opening a new
one.
CDBM_I_OLD_WITHOUT_HEADER 0X4004C823 Use of an old DBM file Format without
(Informational) Header
CDBM_E_HR_FROM 0XC004C824 An HRESULT was received from a
Subroutine
CDBM_E_PARAMETER 0XC004C825 A Parameter is invalid
CDBM_E_NOTIMPL 0XC004C826 Method is currently not implemented
CDBM_E_OUTOFMEMORY 0XC004C827 Out of memory
CDBM_E_NO_OPEN_TRANSACTION 0XC004C828 No transaction open
CDBM_E_NO_CONTENTS 0XC004C829 No contents available
CDBM_REC_NO_NOT_FOUND 0XC004C82A Record not found
CDBM_STRUCTURE_ELEMENT_ NOT_FOUND 0XC004C82B Element of the Structure not found
CDBM_E_NO_MORE_RECORDS_ IN_TABTYPE 0XC004C82C Table type 3 can contain only one record
CDBM_E_WRITE 0XC004C82D The data in the VARIANT must be given in
a SafeArray
CDBM_E_WRITE_NO_PARRAY 0XC004C82E The VARIANT contains no valid [parray]

element
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ODM Error Codes DBM V4

Error Code (Definition) Value Description

CDBM_E_WRITE_CANT_ ACCESS_DATA 0XC004C82F Unable to access SafeArray Data in the
VARIANT

CDBM_E_WRITE_DATA 0XC004C830 To write the data of this Element it must be
given as a BSTR, or as an Array of
VT_UIL/VT 11

CDBM_E_WRITE_BSTR_E1 0XC004C831 The BSTR string must have an even
length.

CDBM_E_WRITE_BSTR_E2 0XC004C832 The BSTR string must contain only hex
digits (0..9 and a/A..f/F).

CDBM_E_WRITE_CANT_ INTERPRET_ARRAY 0XC004C833 Unable to interpret data in the SafeArray.

CDBM_E_WRITE_VT_ERROR 0XC004C834 Data type in the SafeArray is not VT_UI1
or VT_I1.

CDBM_E_WRITE_LENGTH 0XC004C835 Data length is invalid for write operation of
this type.

CDBM_WRITE_ELEMENT 0XC004C836 Element not found in the Record of the
Table

CDBM_MIN_MAX_ERROR 0XC004C837 Can't write data because of min underflow
or max overflow

CDBM_TABLE_EXIST 0XC004C838 Table already exist in the database

CDBM_MIN_MAX_INVALID 0XC004C839 The Min value is greater than the Max
Value

CDBM_DEF_MIN_MAX_INVALID 0XC004C83A The Default Value is not in the range
between the Min value and the Max Value

CDBM_CANT_CHANGE_STRUCTURE_ 0XC004C83B It's not allowed to change the structure

WHILE_RECORDS_EXIST while Records exist in the Table

CDBM_NEW_STRUCT_NEEDS_TYPE 0XC004C83C In a newly added structure the data type
must be set also

CDBM_VALUE_ERROR 0XC004C83D Range error while validating a value

CDBM_DATATYPE_ UNSUPPORTED_IN_RCS 0XC004C83E The data type is unsupported in the RCS
file format

CDBM_I_COUNT_OF_TABLES _ 0X4004C83F The count of Tables exceeds the RCS

EXCEEDS_RCS_RANGE

(Informational)

range of Tables. This can cause problems
if the file is downloaded to RCS Systems

CDBM_|_COUNT_OF TABLES_
EXCEEDS_OLDDBM_RANGE

0X4004C840
(Informational)

The count of Tables exceeds the
DBM32.DLL range of Tables. This can
cause problems if the file is used with older
Tools using the DBM32.DLL

CDBM_UNSUPPORTED_DATATYPE_ 0XC004C841 The Data type is not compatible with the
IN_RCS_MODE old database format
CDBM_WRITE_UNSTRUCTURED_1 0XC004C842 The data of an unstructured record can
only be written with the "Write' Method not
with ‘WriteElement'.
CDBM_READ_UNSTRUCTURED_1 0XC004C843 The data of an unstructured record can
only be read with the 'Read' Method not
with '‘ReadElement'
CDBM_WRITE_DATA_LENGTH_ INVALID 0XC004C844 The given data length doesn’t correspond
with the expected data length.
CDBM_UNKNOWN_VIEW_MODE 0XC004C845 The View Mode is unknown.
CDBM_E_DIAG_TABLE 0XC004C846 It doesn’t make much sense to add or
delete records from a diagnostic table
because those changes are never saved.
CDBM_E_ADR_STRING_ERROR 0XCo004C847 The given Address string doesn't fit the

required format of this type where all
address bytes must be in the range
between 0 and FF
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ODM Error Codes DBM V4

Error Code (Definition) Value Description
CDBM_ERROR_FROM_VAR_ CHANGE_TYPE 0XC004C848 Function VariantChangeType return an
error when trying to convert the Parameter
CDBM_E_MINERROR 0XC004C849 Error while comparing the Value with the
lower range
CDBM_E_MAXERROR 0XC004C84A Error while comparing the Value with the
upper range
CDBM_E_RANGE_ERROR 0XC004C84B Value out of Range
CDBM_E_TABLE_TYPE1 0Xcoo4cs4ac Table type 1 doesn’'t have a unique record
length over all records
CDBM_E_TABLE_TYPE3_ ADDREC 0XC004C84D Table type 3 doesn't allow to insert more
than one Record
CDBM_E_TABTYPE1 0XC004C84E It's not allowed to insert more Records
than structure definitions in Table Type 1
CDBM_E_TOGGLE_NOT_FOUND 0XC004C84F Could not find the string for this value in
the list of valid toggle strings
CDBM_E_TOGGLE_VALUE_IS_EMPTY_STRING | 0XC004C850 The toggle string for this value is empty.
CDBM_VARIANT2BYTEARRAY_ ERROR 0XC004C851 Error during conversion of Variant to byte
array
CDBM_E_SET_ELEM_PROP_ DEPENDENCY 0XC004C852 The Toggle Type needs also the additional
string and the additional number entries in
the Method
CDBM_E_TABTYPE1_REC_ 0XC004C853 When reading the records of Table type 1
DOESNT_CORRESPOND_ WITH_ELEMENT elementwise the record number must
correspond with the element number
CDBM_TABTYPE1_NO_DATA_ 0XC004C854 When reading the records of Table type 1
FOUND_FOR_RECORD and structure definitions are present it's
assumed that for each structure element a
corresponding record must exist
CDBM_E_TABTYPE1l_WRITE_ 0XC004C855 When writing the records of Table type 1
ELEMENT_NE_RECORD elementwise and structure definitions are
present it's only allowed to write the
corresponding element number in each
record
CDBM_E_TABTYPE1l_WRITE_ 0XC004C856 When writing the records of Table type 1
ELEMENT_NOT_FOUND with an array and structure definitions are
present it's assumed that a corresponding
element number of this record exist
CDBM_I_TABLE_NAME_EXCEEDS _ 0X4004C857 The Table name exceeds the maximum
RCS_RANGE (Informational) length of RCS compatible Table names
CDBM_W_CUT_STRING 0X8004C858 The string exceeds the maximum length
(Warning) and will be limited to the maximum length
CDBM_I_STRING_TOO_SHORT 0X4004C859 The string is below the minimum length.
(Informational) The minimum length will be reduced.
CDBM_I_STRING_TOO_LONG 0X4004C85A The string is exceeding the maximum. The
(Informational) maximum length will be extended.
CDBM_E_STRING_TOO_SHORT 0XC004C85B The string is below the minimum length.
(Error)
CDBM_E_STRING_TOO_LONG 0XC004C85C The string is exceeding the maximum
(Error) length
CDBM_E_WRONG_TYPE_ FOR_WRITE 0XC004C85D Writing on the Element type with the given
Data type is not implemented
CDBM_E_NO_APPEND_IN_ 0XC004C85E Method IDbmRecord::AppendData is not

STRUCTURED_RECORDS

allowed for structured records
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ODM Error Codes DBM V4

Error Code (Definition) Value Description
CDBM_E_DATA_UNAVAILABLE 0XCO004C85F No data available
CDBM_E_CANT_CONVERT_ INTO 0XC004C860 Unable to convert the value into the
Element type
CDBM_E_DBM_FILE_OVERFLOW 0XC004C861 You try to write a RCS like database which
needs too much bytes
CDBM_E_PW_ERROR 0XC004C862 Password not correct
CDBM_E_FILELENGTH_CORRUPT 0XC004C863 The file length doesn’t correspond to the
length given in the Header.
CDBM_E_STRUCT_TYPE 0XC004C864 Error in the file.
CDBM_E_MD5SUM_INVALID 0XC004C865 MD5 sum invalid
CDBM_E_STRUCT_LENGTH 0XC004C866 Error in the expected and given structure
length at a specific offset in the file.
CDBM_E_APPEND 0XC004C867 Append of data is only allowed if the
Record contains only one data field and
the field type will support this
CDBM_APPEND_NOT_ SUPPORTED 0XC004C868 Append of Data not supported by this filed
type
CDBM_DATA_TYPE_APPEND_ ERROR 0XC004C869 Can't append Data of this type.
CDBM_E_UNSTRUCTURED_TABLE_ 0XCO004C86A A Table without structure information
DOESNT_SUPPORT_LENGTH doesn’t support a record length
CDBM_E_DISABLED_WHILE_ 0XC004C86B The Method is disabled while a transaction
TRANSACTION_IS_OPEN is open. Please close this one first and call
the Method again.
CDBM_E_UNABLE_TO_CALL_ 0XC004C86C The Method is disabled on a LinkedList
READ_ON_LINKED_LIST type. Please use the IRecordCollection on
this type.
CDBM_E_ELEMENT_HAS NO_ 0XC004C86D An Element from a Table has no
SUBSTRUCTURE substructure
CDBM_STRUCT_ERROR_FROM _ 0XC004C86E Error from calling VariantChangeType
VAR_CHANGE_TYPE
CDBM_E_FOREIGNKEY_DEF 0XC004C86F The definition of a FOREIGNKEY must
contain the name of the related Table in
the description and this Table must exist at
this time
CDBM_E_FOREIGNKEY_ REF_TAB 0XC004C870 The description of a FOREIGNKEY must
refer to a Table of type
‘eDbmTableTypeLinkedList'
CDBM_E_KEY 0XC004C871 To create a Record Collection with a KEY
it's necessary to have the data type KEY at
the first position in all Records of the
searched Table
CDBM_E_KEY_TABLE_TYPE 0XC004C872 This Method needs a Table of type
‘eDbmTableTypeLinkedList'
CDBM_DATATYPE_NOT_ IMPLEMENTED 0XC004C873 This data type is currently not implemented
CDBM_INSERT_POS_NOT_ FOUND 0XC004C874 The position of the Record where the new
one should be inserted wasn’t found
CDBM_E_INSERT_REC_QI 0XC004C875 Error during insertion of a Record
CDBM_E_TAB_PROP 0XC004C876 Invalid Property in Table
CDBM_E_KEY_NOT_FOUND 0XCo004C877 The KEY wasn't found in the Table
CDBM_E_KEY_INVALID 0XC004C878 The KEY is invalid for this operation

Table 64: ODM Error Codes DBM V4
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12 Appendix

12.1 User Rights

12.1.1 Settings

User-rights are set within the FDT-container. Depending on the level the
configuration is accessible by the user or read-only.

To access the Settings, Configuration, Device Description and
Diagnosis panes of the EtherCAT Slave DTM you do not need special
user rights. Also all users can select the decimal or hexadecimal Display
mode or sort table entries.

Note: To edit, set or configure the parameters of the Settings and
Configuration panes, you need user rights for Maintenance, for Planning
Engineer or for Administrator.

The Device Description panes do not contain any editable elements. The
indicated values in are only for information purposes.

The following tables give an overview of the user right groups and which
user rights you need to configure the single parameters.

Observer Operator Maintenanc Planning Adminis-
e Engineer trator
Driver D D X X X
Verify or adapt Driver Settings - - X X X
Configuring netX Driver - - X X X
Device Assignment D D X X X
Scanning for Devices - - X X X
Selecting the Device (with or - - X X X
without firmware)
Selecting the Device once more - - X X X
(with Firmware)
Firmware Download D D X X X

Table 65: Settings (D = Displaying, X = Editing, Configuring)

12.1.2 Configuration

Observer Operator Maintenanc | Planning Administra
e Engineer tor
General D D X X X
General Settings D D X X X
Behavior D D X X X
Mailbox D D X X X

Table 66: Configuration (D = Displaying, X = Editing, Configuring)
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12.5 Glossary

CoE

DDF

DTM

E2PROM

E-Bus

EDS

EtherCAT-Master

EtherCAT-Port

EtherCAT-Slave

FDT

CANopen over EtherCAT

CoE denominates a method for accessing an object dictionary which has
been adopted for use in EtherCAT from CANopen.

Device Description File.

Device Type Manager.

The Device Type Manager (DTM) is a software module with graphical user
interface for the configuration or for diagnosis of devices.

Electronically erasable Programmable Read-Only Memory

Bus system based on LVDS standard (specified in the ANSI/TIA/EIA-644-
1995 standard)

Electronic Data Sheet

A device which is responsible for the configuration, parameterization of the
EtherCAT segment, all connected devices’ controllers, and cyclic process
data exchange, mailbox and diagnostics services.

Physical type of data transmission used by EtherCAT. An EtherCAT Slave
Controller can have up to 4 EtherCAT ports. Can be one of the following
three alternatives:

* E-Bus
¢ 100Base-TX
* 100Base-FX

A device which is configured by the Master, receives telegrams with output
data, commands from it and provides input and status data.

Field Device Tool

FDT specifies an interface, in order to be able to use DTM (Device Type
Manager) in different applications of different manufacturers
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FMMU
Fieldbus Memory Management Unit
A FMMU organizes the mapping of logical EtherCAT addresses to physical
addresses.
LVDS

Object Dictionary

ODMV3

PDO

SDO

Sync Manager

XML

Low Voltage Differential Signals

A data transmission standard specified in ANSI/TIA/EIA-644-1995 and
used in Beckhoff's E-Bus.

An obiject dictionary is a storage area for device parameter data structures.
It is accessed in standardized manner very similarly as this is done in
CANopen.

The Online-Data-Manager Version 3 (ODMV3) is an application interface.
The ODMV3 works as a server, which can be run as an out-proc server or
system service. Its task is to provide different applications (e.g.
SYCON.net), access to multiple devices and even share one device
amongst several applications.

Process Data Object

Specific data object for cyclic data communication.

Service Data Object

Specific data object for acyclic data communication, i.e. mailbox-based
communication. It is typically used for accessing the object dictionary.

Synchronization Manager

A sync manager synchronizes the data communication on a specific
communication channel. It is configured for managing either input or output
and for working either cyclically or acyclically based on mailboxes.
Configuration is done within the DDF file. Up to 4 sync managers numbered
0 to 3 can be configured.

Extensible Markup Language

A versatile data storage format defined by the World Wide Web Consortium
(W3C). It is based on elements and attributes. In EtherCAT, it is used in
device descriptions stored in DDF files.
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12.6 Contacts

Headquarters

Germany

Hilscher Gesellschaft fiir
Systemautomation mbH
Rheinstrasse 15

65795 Hattersheim

Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-Mail: info@hilscher.com

Support
Phone: +49 (0) 6190 9907-99
E-Mail: de.support@hilscher.com

Subsidiaries

China

Hilscher Systemautomation (Shanghai) Co. Ltd.

200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-Mail: info@hilscher.cn

Support
Phone: +86 (0) 21-6355-5161
E-Mail: cn.support@hilscher.com

France

Hilscher France S.a.r.l.

69500 Bron

Phone: +33 (0) 4 72 37 98 40
E-Mail: info@hilscher.fr
Support

Phone: +33 (0) 4 72 37 98 40
E-Mail: fr.support@hilscher.com

India

Hilscher India Pvt. Ltd.
Pune, Delhi, Mumbai
Phone: +91 8888 750 777

E-Mail: info@hilscher.in

Italy

Hilscher ltalia S.r.l.

20090 Vimodrone (MI)

Phone: +39 02 25007068
E-Mail: info@hilscher.it
Support

Phone: +39 02 25007068
E-Mail: it.support@hilscher.com

Japan

Hilscher Japan KK

Tokyo, 160-0022

Phone: +81 (0) 3-5362-0521
E-Mail: info@hilscher.jp
Support

Phone: +81 (0) 3-5362-0521
E-Mail: jp.support@hilscher.com

Korea

Hilscher Korea Inc.

Seongnham, Gyeonggi, 463-400
Phone: +82 (0) 31-789-3715
E-Mail: info@hilscher.kr

Switzerland

Hilscher Swiss GmbH

4500 Solothurn

Phone: +41 (0) 32 623 6633
E-Mail: info@hilscher.ch

Support
Phone: +49 (0) 6190 9907-99
E-Mail: ch.support@hilscher.com

USA

Hilscher North America, Inc.
Lisle, IL 60532

Phone: +1 630-505-5301
E-Mail: info@bhilscher.us

Support
Phone: +1 630-505-5301
E-Mail: us.support@hilscher.com
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